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What's New

Citrix Simple License Service  - Enables allocat ion and installation of license files on a license server using a web page 

interface. Connect t o the Simple License Service locally wit h the Start menu shortcut or remotely with the Simple License 

Service URL. (Builds 13012 or 13017 )

Citrix Web Services f or Licensing - Replaces the Citrix Licensing Configurat ion Service. T he enhanced Cit rix Web 

Services f or Licensing provides similar functionality for newer product consoles, as well as addit ional functionality. (Builds 

13012 or 13017)

IPv6 and IPv4 - This release supports pure IPv4, pure IPv6, and dual-stack deployments that use overlapping IPv4 and 

IPv6 networks. (Builds 13012 or 13017)

Fixed issues

This f ix addresses the security vulnerability CVE-2014-0160 (Heartbleed). For more information, see Knowledge Center

article CTX140605. [#0479792] (Build 13017)

When a locally managed user having an administrator role does not exist, a domain administrator can only add domain

users or groups as administrators to the license server. To edit and delete domain administrators or groups on the User

Configuration page in the License Administration Console, a locally managed user having the Administrator role must

exist. [#0263016 and #0269719] (Build 13017)

In the License Administration Console, localized characters in user names and passwords can display with unexpected

results. To avoid this issue, use US-ASCII alphabetic letter characters for user names and passwords in the License

Administration Console. [#0272738, #0273089, #0156833, #0156839, #0156969, #223870, #242767] (Build 13017)

This release of the Simple License Service displays in English only. [#0310912] (Builds 13012 and 13017)

Known issues

This section contains:

Installation issues

Other known issues

Simple License Service

License f iles

Event log viewer messages

Product-specif ic issues

Installation issues

If  Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled (the default configuration for

Windows 2008), connections can fail. Connecting remotely to the console or checking out licenses works until failover

occurs in the cluster. Exception rules for CITRIX.exe and lmadmin.exe are created during installation of Licensing and

Simple License Service, but do not work after a cluster failover. To work around this issue, create exceptions for Licensing

components on the Exceptions tab of the Windows Firewall panel. Create an exception for each of the following ports:

http://support.citrix.com/article/CTX140605
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Console Web Server port (default port is 8082); License Server Manager port (default port is 27000); Simple License

Service port (default port is 8083); and Vendor Daemon port (default port is 7279). This issue occurs with Windows Server

2008 (32-bit and 64-bit), Windows Server 2008 R2, and Windows Server 2012. For more information, see

http://support.microsoft.com/kb/2568645. [#232365]

At the end of installation, the "License Server Configuration" tool is presented. If  you choose to cancel on this page, the

license server does not start. You must reopen the License Server Configuration tool and f inish the settings before the

license server can start. You can open the tool from: C:\Program

Files\Citrix\Licensing\LS\resource\LSPostConfigTool.exe. If  the License Server Configuration tool fails for any reason,

uninstall and reinstall the license server.

During installation, localized characters in the installation path can cause the installation to fail. Accept the default

installation path or enter only ASCII alphabetic letter characters for the installation directory. [#229456]

When configuring the product-side setting for the license server name, do not use localhost. Though you can use the

host name, IP address, or FQDN instead, Citrix recommends you use the FQDN. [#165986]

When you have the Citrix License Server 11.11.1 installed and then install XenDesktop 5.6, the 30-day free trial license is

the only license available to you. Workaround: Accept the trial license and complete the installation. Use Desktop Studio

to change the product edition and license model settings after the installation. [#0388512]

The user list for the License Administration Console and the Citrix Simple License Service web page does not support

non-ASCII characters in user/group names. Due to this limitation, on a Russian operating system, the BUILTIN

Administrators group is not added to the user list, as it is created with non-ASCII characters. This applies to both fresh

installs and upgrades. Any users belonging to the BUILTIN Administrators group in an earlier release of XenDesktop and

the Simple License Service will not have access to the License Administration Console or the Simple License Service after

an upgrade.

As a workaround, add ASCII-character versions of Russian users/groups names post installation using the License

Administration Console interface. Alternatively, install the license server on one of the other supported operating

systems. [#0395305]

Other known issues

If  the User Account Control (UAC) is enabled during an upgrade, the License Server Configuration tool’s f ields are blank

and the Port Configuration page does not display port numbers. If  this occurs, you cannot use the License Server

Configuration tool to configure the License Server. Workaround: Disable UAC before upgrading to this release.

[#0477788]

If  you click Save in the Server Configuration page and the port is busy, this message is displayed:

The existing port configuration might already be in use or there might be a conflict. Ensure there are no conflicts before

starting the License Server. [#0482654]

If  you include a backslash in a locally managed user name (for example, test\), you cannot delete the user. [#0270349]

Changing the licensing port after licenses are installed might cause the No such product or vendor exists: CITRIX

message to appear on the Dashboard instead of the installed licenses. [#0269423]

When you try to start the License Administration Console or the Simple License Service, a blank page might display if  the

Internet Explorer Enhanced Security Configuration is enabled and the License Administration Console or the Simple

License Service is not in the Trusted Sites. Workaround: Disable Internet Explorer Enhanced Security Configuration.

[#382429]

Older Desktop Studio releases (prior to XenDesktop 7 Studio) using this version of the license server do not display

license usage information or manage the license server using the Licensing Node. This version of the license server is fully

compatible with XenDesktop and can serve licenses for any Citrix product deployment. If  you continue to use an older

http://support.microsoft.com/kb/2568645
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Desktop Studio, use the License Administration Console that ships with the license server to display license usage,

manage license server users, and upload licenses. If  you are using a version of XenDesktop prior to the XenDesktop 7 and

you upgrade from earlier versions of Citrix License Server for Windows to version 11.11.1, you might see the following

warning:

Warning: Installing this update removes the Licensing Configuration Service. As a result, all versions prior to this release of

Studio provide only limited licensing information.

Simple License Service

When you start the Simple License Service from the Start menu shortcut, the Chrome browser might become

unresponsive. Workaround: Type the Simple License Service URL directly into the Chrome browser. [#0314254]

If  the License Administration Console is disabled in your XenDesktop installation, only administrators can use the Simple

License Service. To allow users access to the Simple License Service, enable the License Administration Console with

Desktop Studio or the Set-LicLACEnabledState PowerShell cmdlet, and then configure the users. [#0311191]

If  you configure the Simple License Service with a port that Firefox or Chrome blocks, you must add an exception to the

browser settings. Note that if  you start the Simple License Service from the Start menu shortcut and you have the

exception set, Chrome ignores it. [#0313924]

The f irewall rule is not removed if  you uninstall the Simple License Service after uninstalling the License Server 11.6.1.

Workaround: Uninstall the Simple License Service before uninstalling the License Server 11.6.1. [#0305195]

When doing a silent installation of the Simple License Service on a 32-bit or 64-bit Windows 2003 or Windows 2008

server with a nonadministrator account, the installation fails and an event log error might not be produced. [#0305202]

License files

Certain license types are not covered by Subscription Advantage and therefore appear in alerts in the Dashboard of the

License Administration Console indicating that the Subscription Advantage date is expired. You can ignore such alerts for

any license not covered by Subscription Advantage. This includes Evaluation licenses, Not for Resale licenses, Early

Release licenses and Technology Preview licenses. These types of licenses do not need Subscription Advantage and your

Citrix products do not stop working when the Subscription Advantage date is expired. You can verify the status of any

license for which you receive an alert by clicking the license on the Dashboard. The license information expands to show

the license type (such as Technology Preview), the license expiration date, and the Subscription Advantage date.

[#231847]

License Files with multiple lines referencing HOSTNAME= are ignored by the license server. Licenses in these f iles cannot

be checked out. This issue is caused when you download licenses associated to different license server hostnames into

the same license f ile. Any of the following error messages might appear in the Event Log Viewer:

Event ID: 724 Description: (2196) Invalid license key.

Event ID: 764 (2196) Wrong hostid on SERVER line in license f ile.

In addition, the License Administration Console displays the following error message: "…Error List Returned…Unknown

Host."

To resolve this issue, download again separate license files for each Citrix product tied to different license server names.

After you replace evaluation license f iles on the license server with new license f iles, the Citrix product might continue to

display the following license expiration message when users log on: "Warning: The following Citrix Product is using an

Evaluation license. This license will expire in…"

To resolve this issue:

1. Remove the old evaluation license f iles from the license server. (See
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— Delete license files

in Citrix eDocs.)

2. At the license server, restart the Citrix Licensing service.

3. At the Citrix product server, point to a f ictional license server and then point the product back to the actual license

server. (See your product's documentation for information about changing these settings.)

4. If  the problem persists, restart the product server.

When you do a partial allocation of User/Device licenses, the overdraft feature applies only to the f irst allocated license.

Future allocations do not receive any overdraft. For more information, see http://support.citrix.com/article/CTX133329.

Event log viewer messages

The following message appears in the Event Log Viewer: (1224) Client/server comm version mismatch. The client and

server programs are running potentially incompatible versions of FLEXnet comm software.

This is an informational message indicating that a Citrix product licensing client is communicating with a different version

of the Citrix License Server. Ignore this message.

After upgrading the license server, messages such as the following example might appear in the Event Log Viewer

(product may vary from this example):

A provider, MgmtEventProv, has been registered in the Windows Management Instrumentation namespace

Root\Citrix\Management to use the LocalSystem account. This account is privileged and the provider may cause a

security violation if  it does not correctly impersonate user requests.

Ignore the message. The upgrade is successful. [#207927, #183919]

Product-specific issues

Access Essentials / XenApp Fundamentals

After installing Licensing 11.10 and starting the Quick Start tool, a .NET Framework error message indicates that “The

service object for the service “CitrixLicensing” could not be acquired. Probably not installed or there is a permission

problem.” This issue occurs in Access Essentials 2.0 or XenApp Fundamentals 3.0. To resolve the issue, uninstall Licensing

11.6.1 Build 10007 and install Licensing 11.6.1 Build 9020, available from the License Server Downloads page. [#232048]

Before installing the license server version 11.10 on systems running Access Essentials 2.0, you must install Hotfixes

AEE200W2K3001 and AEE200W2K3002. Failure to do so might render Access Essentials inoperable.

Citrix Branch Repeater with Windows Server

If  you install the same license twice, the second time may trigger a change in the Send Bandwidth Limit, which will be set

to the maximum licensed speed. To solve this issue, do not install the same license twice. If  you must do so, verify that

the Send Bandwidth Limit is set correctly. [#53894]

Citrix MetaFrame Access Suite 3.0

Upgrading licensing from Citrix MetaFrame Access Suite 3.0 to a newer version of licensing. During the upgrade process

of the license server, the licensing components are detected as installed but there is a prompt to remove them. You

cannot upgrade licensing in a Citrix product that has licensing 1.0.0 installed as it is incompatible with the licensing that is

used in Citrix products today. Uninstall the licensing components and reinstall the latest version. [#217704]

Citrix XenApp Management Pack

http://docs.citrix.com/en-us/licensing.html
http://support.citrix.com/article/CTX133329
http://www.citrix.com/English/ss/downloads/index.asp
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Details about the Citrix License Server are always blank on the Monitoring tab of the System Center Operations

Manager for Citrix Managed Servers. There is no workaround for this issue. [#192159]

Finding information for your version of  licensing

Updated: 2015-03-12

See the tables below for a list of license server versions and their associated documentation.

Important: Citrix does not provide hotfixes for license server components and does not support older license servers with
newer products. The latest versions of the license server often contain resolutions to issues appearing in earlier versions.
When you upgrade or install new Citrix products, upgrade the licensing components as well. New license servers are
backward compatible and will work with older products and license f iles; however, new products often require the newest
license server to check out licenses correctly. You can f ind the latest version from the Citrix Downloads site.

To find your license server version number

If  you are unsure if  your license server version is current, you can verify it by comparing your version with the number on the

Downloads site.

On a license server with the License Administration Console:

1. Start the License Administration Console from the programs menu: Citrix > Management Consoles > License

Administration Console.

2. Click Administration and select the System Information tab. See the release version in the information list.

On a license server without the License Administration Console:

1. Open the Registry Editor (Start > Run > regedit).

Note: Use Registry Editor to view the license server information only. Editing the Registry can cause serious problems

that may require you to reinstall your operating system.

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\LicenseServer\Install.

The version number appears in the Version key in the format: 11.12.1.0 build 14100.

On servers running Windows 2008 Server 64-bit the registry key is

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\LicenseServer\Install

http://www.citrix.com/English/SS/downloads/downloads.asp?dID=36239
http://www.citrix.com/English/SS/downloads/downloads.asp?dID=36239
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System requirements

Mar 16, 2015

Requirements for Licensing for Windows

Citrix Licensing is compatible with the same hardware required to support the compatible operating systems. No additional

hardware is required.

Note: The license server does not support multi-homing (two network cards plugged into distinct networks).
The License Administration Console manages the license server on the computer on which it is installed. It cannot manage

remote license servers. The Simple License Service can install licenses only on the license server where it is installed.

Operating Systems You can install the license server on servers running the following Microsoft operating systems.

Citrix recommends that you install the latest Microsoft Service Pack and updates.

Windows Server 2008 Family

Windows Server 2008 R2 Family

Windows Server 2012 Family

Windows Server 2012 R2 Family

Windows 7, 32-bit and 64-bit editions

Windows 8, 32-bit and 64-bit editions

Windows 8.1, 32-bit and 64-bit editions

Disk Space

Requirements

50 MB for the licensing components

2 GB for User/Device licensing

Microsoft .NET

Framework

Requirements

Microsoft .NET Framework 3.5 is required.

Browsers Internet Explorer Version 8 and 9 in compatibility mode

Mozilla Firefox Version 14.0 and 15.0

Chrome Version 14.0 and 15.0

Safari Version 5.1
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Architecture

Mar 16, 2015

Before you can use your Citrix product, you must install Citrix Licensing. Citrix Licensing is a system of components that

function together. This system includes:

License server - A system that allows licenses to be shared across the network.

License f iles - The f iles that you need to license your product. These f iles are stored on the license server.

Console - The interface you use to manage your license f iles and your license server. For Licensing version 11.6.1 and later,

this is the License Administration Console. (For previous versions, this is the License Management Console.)

Simple License Service - Enables allocation and installation of license f iles on a license server using a web page interface.

Product-side settings in your Citrix products that are associated with the license server.

Overview of  Citrix Licensing

Every Citrix product environment must have at least one shared or dedicated license server. License servers are computers

that are either partly or completely dedicated to storing and managing licenses. Citrix products request licenses from a

license server when users attempt to connect.

Servers running Citrix products contact the license server to obtain licenses.

When users connect to a Citrix product, it draws licenses from the license server. That is, the Citrix product requests to

check out a license from the license server on behalf  of the user or client device. When the license is successfully checked

out, the user can run the product.

Depending on the size and configuration of your product deployment, you may deploy licensing on a server shared with

other applications, a dedicated license server, or multiple license servers.

License files must be located on the license server that is associated with the product you are licensing and the product

must be configured to communicate with that specific license server. The License Administration Console lets you manage

and monitor your Citrix licenses by providing a user interface to the license server. You can view a dashboard of licenses and

alerts, import license files, and manage license server settings.

Licensing operations overview
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Typically, the first time a user connects to a Citrix product, the product requests a license from the license server. When the

license server grants a license request, the Citrix product reserves a license for its use. Reserving licenses for this purpose is

known as checking out licenses. When the user logs off  from the product server, the product returns the license to the

license server. This process is known as checking in licenses. With some Citrix products the license is checked out as soon as

a user connects to the product, and the license remains checked out for a predetermined amount of time.

Each time a Citrix product starts, it opens a connection to the license server by checking out the startup license. The

startup license is a Citrix system file that enables Citrix products to maintain a continuous connection to the license server.

The following figure shows that each product forms its own constant connection to the license server.

The Citrix product makes a continuous connection to the license server. The license server can support up to 10,000

continuous connections.

For example, when a server running XenDesktop requests a license, the product retrieves the license server name and port

number information from the data store and establishes a connection to acquire the appropriate licenses.

There are three stages of the license checkout process.

A Citrix product goes through a three-step process to check out licenses:

1. At startup, a computer running a Citrix product checks out a startup license.

2. A client device connects to the product server.

3. The product requests a license from the license server.

Citrix products, such as XenDesktop, store a replica of the licensing information from the license server, including the

number and type of licenses. If  a Citrix product server loses its connection to the license server, the product enters a grace

period and uses its local record of the licenses to continue licensing the product during the grace period. Citrix products

update this record every hour.

Grace periods

If  product servers lose communication with the license server, the users and the products are protected by a grace period

that allows the product servers to continue operations as if  they were still in communication with the license server. After a

startup license is checked out by the Citrix product, the product and the license server exchange "heartbeat" messages

every five minutes to indicate to each other that they are still up and running. If  the product and the license server fail to

send or receive heartbeats, the product lapses into the licensing grace period and licenses itself  through cached

information.
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The grace period is set by Citrix. It is typically 30 days but can vary depending upon the product. The Windows Event Log

indicates if  the product has entered the grace period, the number of hours remaining in the grace period. If  the grace period

runs out, the product stops accepting connections. After communication is re-established between the product and the

license server, the grace period is reset.

The grace period takes place only if  the product has successfully communicated with the license server at least once.

Note: For products that operate in disconnected mode, the grace period takes effect after the preconfigured time
specif ied for the license check-out expires.
Disconnected mode

Some Citrix products can operate in a disconnected mode (not connected to the server). These products allow a user to

check out a license and operate the product for a preconfigured period of time that is set by the administrator. In this case,

heartbeat messages are not exchanged. One example of disconnected mode is when a user checks out a Single Sign-on

license for a laptop, and then uses the laptop when it is not connected to the server. For products that operate in

disconnected mode, the grace period takes effect after the preconfigured time specified for the license check-out expires.

License server components

The license server comprises several licensing components:

Citrix vendor daemon

Console

License f iles

Options f ile

Startup license

Figure 1. License Server Components. This diagram shows the Citrix product using TCP/IP to connect to license server
components.

Citrix vendor daemon

Licenses are granted by the Citrix vendor daemon (CITRIX.exe), a process that runs on the license server. The Citrix vendor

daemon tracks the number of licenses that are checked out and which product has them. Citrix products communicate

with the Citrix vendor daemon using TCP/IP. By default, the Citrix vendor daemon uses TCP/IP port 7279.

License f iles
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License f iles are text f iles created by Citrix that store licensing data. They contain information about the product licenses

and the number of licenses, as well as system information such as the name of the license server. The license server uses

these f iles to determine whether to grant a license to a Citrix product.

Startup license

The startup license (citrix_startup.lic) allows Citrix products to communicate with the license server using a continuous open

connection. The startup license:

Tracks which product servers are connected to the license server

Stores licensing system information

Does not affect your license count

Caution: Do not edit the startup license f ile, or any other license f iles.

Options f ile

The options f ile (Citrix.opt) is a license server configuration f ile that the Citrix vendor daemon reads every time it restarts or

receives a command to reread the f ile. This configuration f ile defines licensing behavior— the number of licenses a product

server can use, the location of the system logs, and other user-defined customizations.

The License request process

When a product requests a license from the license server, the Citrix vendor daemon determines whether a license is

available for the request.

The license request process has two phases: the product startup phase and the user connection phase.

Product Start-Up Phase

When a Citrix product starts, it retrieves the license server location from its data store

The product connects to the Citrix vendor daemon

The product checks out a startup license

User connection phase

A user connects to a computer running the Citrix product

The product requests a license from the license server

The Citrix vendor daemon checks to see if  any licenses are available and grants or denies the product's request

The license module in the product grants or denies the use of the product based on the response from the Citrix vendor

daemon
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Get started

Mar 16, 2015

Citrix recommends that you upgrade the license server to the latest version when you upgrade or install new Citrix products.

New license servers are backward compatible and work with older products and license files. New products often require

the newest license server to check out licenses correctly.

Licensing your product includes the following steps:

1. Ensure you have the latest license server version

2. Verify system requirements

3. Install licensing

4. Obtain license f iles from My Account

5. Install your Citrix product (or, if  already installed, restart the Citrix products for the new licenses to be recognized)

6. Configure product-side licensing communication settings that were not set during product installation, if  applicable. This

includes setting the correct product-edition in the product. Details about these settings are covered in the product

documentation.

Ensure that the product-side edition setting correctly matches the licenses you have purchased. For example, if  you

purchased Platinum edition licenses, ensure that the edition setting in the product indicates Platinum— not Enterprise or

any other edition.

See Architectural Overview for an overview of the licensing components and process.

http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-version.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-licensing-prerequisites.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-install.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-install-license-files.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-architecture.html
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Ensure you have the latest license server

Apr 08 , 2013

When upgrading or installing new Citrix products, always upgrade the license server. The new license server is
backward compatible and will work with older products and license f iles; however, new products require the newest license
server to check out licenses correctly. You can install or upgrade the latest version from the product media.
Note: Citrix does not provide hotfixes for license server components and does not support older license servers with newer
products. The latest versions of the license server often contain resolutions to issues appearing in earlier versions.

To find your license server version number

If  you are unsure if  your license server version is current, you can verify it by comparing your version with the number on the

Downloads site.

On a license server with the License Administration Console:

1. Start the License Administration Console from the programs menu: Citrix > License Administration Console.

2. Click Administration and select the System Information tab. See the release version in the information list.

On a Windows license server without the License Administration Console:

1. Open the Registry Editor (Start > Run > regedit).

Note: Use Registry Editor to view the license server information only. Editing the Registry can cause serious problems

that may require you to reinstall your operating system.

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\LicenseServer\Install.

For example, the version number appears in the format: 11.x.x build number.

http://www.citrix.com/English/SS/downloads/downloads.asp?dID=36239
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Security considerations

May 02, 2013

Citrix recommends that you upgrade the license server to the latest version when you upgrade or install new Citrix products.

New license servers are backward compatible and work with older products and license files. Each time a new license server

is released, it may contain better securityfeatures than in previous versions.

Citrix also recommends the following security considerations when you configure your environment or use the Licensing

Administration Console.

Configure the license server environment so that only authorized administrators on a trusted network are permitted to

access the Licensing Administration Console port. You achieve this with an appropriately configured network or host-

based f irewall.

When using the Licensing Administration Console, avoid visiting untrusted websites or clicking on untrusted URLs.
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Firewall considerations

Feb 27, 2013

Determine if  you need to place a firewall between the license server and any product servers. Citrix recommends that you

determine if  your products will communicate with the license server through a firewall before installing licensing. Where you

install the license server can be impacted by firewall considerations.

If  there is a f irewall between your product or Single Sign-on (Password Manager) Agent and the license server, you need to
configure port numbers. This configuration process entails:

Determine which port numbers you need to change. You can change port numbers during the installation process or

afterward.

Open up the f irewall ports. Open any ports on the f irewall that you modif ied so that traff ic can f low. For Windows

Server 2008, the license server Version 11.5 or later configures the built-in f irewall automatically.

Modify the product-side settings. Your Citrix product must be configured with the same port numbers as those in the

License Administration Console. If  you do not change the port number referenced in the product, the product cannot

contact the license server. You can change the product-side settings during and after installation of the product. See

your product’s documentation for information about these settings.
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Install licensing components for Windows

May 20 , 2013

Licensing components can either be installed on a separate, dedicated server or on a server they share with another application (for example,

a backup data collector, farm metric server or terminal server license server). Alternatively, you can use a Web or application server; however,

the locations mentioned below are less resource intensive. If  you are running fewer than 50 servers or 10,000 licenses, you can install the

license server on the same server as your product. You can monitor CPU and Memory load (lmadmin.exe and CITRIX.exe) to determine if  you

should relocate the license server to another system.

Software and Hardware Requirements

Firewall Considerations

To install the license server and console using the setup wizard

At the end of the installation, the "License Server Configuration" tool is presented. If  you choose to cancel on this page, the license server

does not start. You must reopen the License Server Configuration tool and finish the settings before the license server can start. You can

open the tool from: C:\Program Files\Citrix\Licensing\LS\resource\LSPostConfigTool.exe.

If  you install the License Server without successfully configuring it with the post installation License Server Configuration tool, any

subsequent License Server upgrades fail.

1. Log on as an administrator or a member of the Administrators group.

2. Insert the product installation media and navigate through the Autorun screens to Citrix Licensing and follow the instructions. The exact

screen names vary, depending on the product.

3. Follow the setup wizard to accept the destination folder. Licensing components are installed in C:\Program Files\Citrix\Licensing on a 32-

bit computer and C:\Program Files (x86)\Citrix\Licensing on a 64-bit computer.

4. From the post installation License Server Configuration tool, accept or change the default port numbers for use by Licensing components.

You can change the port numbers after the installation, if  needed.

License server port number is 27000

Vendor daemon port number is 7279

Console Web port is 8082

Simple License Service port is 8083

5. If  you are in a domain, the license server adds the installing user (domain\user) as a default License Administration Console administrator. If

you are a local Windows user, the license server adds the installing user (computer\user) as a default License Administration Console

administrator. There is also a BUILTIN\administrator, which allows any administrator to manage licensing. You can remove

BUILTIN\administrators to restrict licensing to specif ied users. Any user that has access to managing the License Administration Console

can also manage the Simple License Service.

You are now ready to go to the Citrix Web site to obtain the license f iles needed to run your Citrix products. This procedure is detailed in
Obtaining Your License Files.

Using the command line to install licensing

When using the Msiexec command to install licensing, set properties by adding Property=“value” on the command line anywhere except

between an option and its argument.

Note: Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges in Windows
Server 2008, choose Start, right-click Command Prompt, and choose Run as administrator.
The following sample command line installs licensing in silent mode and creates a log file to capture information about this operation. Add the

properties you want to set after the switches.

Type the command in one line without returns. The following example shows multiple lines due to space limitations.

msiexec /I ctx_licensing.msi /l*v install .log /qn INSTALLDIR=installdirectory LICSERVERPORT=portnumber  
VENDORDAEMONPORT=portnumber MNGMTCONSOLEWEBPORT=portnumber WEBSERVICELICENSINGPORT=portnumber 
where:

http://docs.citrix.com/en-us/licensing/11-11-1/lic-licensing-prerequisites.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-fs-accessing-firewall-c.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-install-license-files.html
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/l*v is the location of the setup log. Optional parameter.

/qn specif ies a silent (quiet) installation.

INSTALLDIR is the location where the license server executable is stored. Optional parameter. The default is c:\program files\citrix licensing

or c:\program files (x86)\citrix\licensing.

LICSERVERPORT is the port number used for the license server. Optional parameter. The default is 27000.

VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter. The default is 7279.

MNGMTCONSOLEWEBPORT is the port number used for the console. Optional parameter. The default is 8082.

WEBSERVICELICENSINGPORT is the port number used for the Simple License Service. Optional parameter. The default is 8083.

msiexec /I ctx_licensing.msi /qn 

If  you are installing in a clustered environment, use the two additional properties in this example:

msiexec /I ctx_licensing.msi /l*v install .log /qn LICSERVERPORT=portnumber  
VENDORDAEMONPORT=portnumber MNGMTCONSOLEWEBPORT=portnumber   
CTX_CLUSTER_RESOURCE_DLL_PATH="c:\ctxlic\" REGISTER_CTX_LS_CLUSTERING="No"
where:

CTX_CLUSTER_RESOURCE_DLL_PATH is the location where the cluster resource DLL executable is stored. Used for clustering only.

REGISTER_CTX_LS_CLUSTERING is either "no" for cluster node 1 or "yes" for cluster node 2. Used for clustering only.
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Obtain your license files

Jun 24 , 2013

After you install the licensing components, you are ready to obtain your license files.

You can obtain your license files in several ways:

Studio in XenDesktop. For more information, see Manage licensing in the XenDesktop 7 documentation in eDocs.

Simple License Service.

License Administration Console.

citrix.com.

Before going to the Citrix web site, you need the following information at hand:

The license code. Find this code: on the Citrix installation media pack, in an email you receive from Citrix, or from the

Subscription Advantage Management-Renewal-Information system (SAMRI).

Your user ID and password for My Account. You can register for this password on My Account.

Note: If  you cannot locate these items, contact Citrix Customer Service.

The name of  the server on which you installed the licensing components. The entry f ield for this name is case-

sensitive, so ensure that you copy the name exactly as it appears on the computer.

You can find the license server host name and Ethernet address in the License Administration Console in the

Administration area on the System Information tab. You can also run the hostname command at a command prompt on

the license server.

How many licenses you want to include in the license f ile. You do not have to download all of the licenses you are

entitled to at once. For example, if  your company purchases 100 licenses, you can choose to allocate and download only

50 at this time. At a later date, you can allocate the rest in another license f ile. You can have more than one license f ile.

To obtain licenses with the Simple License Service

Considerations - Be aware of these considerations when using the Simple License Service to allocate and download

licenses:

The Simple License Service allocates and downloads all the licenses available for a specif ic product. If  you want to

allocate and download only some of the licenses for a product, use My Account.

Once you click Allocate and Download, you cannot cancel it. If  the Allocate and Download fails, use My Account at

citrix.com.

The Simple License Service can allocate only retail licenses (no evaluation or demo licenses or Subscription Advantage

renewals) and does not support redownloading or reallocating of license f iles. For those features, use My Account.

If  you rename the license server, you must reallocate any license f iles allocated under the old license server name and

update the Simple License Service shortcut. You cannot use the Simple License Service to reallocate license f iles. For

more information about reallocating f iles, see Reallocate license f iles in Citrix eDocs.

1. In the Start menu, click All Programs > Citrix > Citrix Simple License Service.

2. If  you want to change the port and/or language, click Configure on the menu bar at the top of the page. Make changes

and click Save.

3. Enter the License Access Code, which is supplied in an email from Citrix.

4. Select a product from the displayed list and click Allocate and Download. All the licenses available for that product are

allocated and downloaded. To select more than one product, choose a product, click Allocate and Download, choose

http://docs.citrix.com/en-us/xa-xd-library/cds-xd-7landing-page/cds-license-landing-/cds-licensing-management.html
http://www.citrix.com/English/ss/supportSecond.asp?slID=11553
http://docs.citrix.com/en-us/licensing/11-11-1/lic-license-files/lic-lf-return-realloc.html
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the next product, click Allocate and Download, and so on and they are processed in order. Note that once you allocate

and download all the licenses for a specif ic License Access Code, you cannot use that License Access Code again. If  you

must perform additional transactions with that code, log on to My Account.

5. To change the port and language, click Configure on the menu bar at the top of the page. Make changes and click Save.

6. To display the newly downloaded licenses, refresh the License Administration Console.

To obtain license files with the License Administration Console

1. Start the console ( Start > All Programs > Citrix > License Administration Console).

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Allocate.

8. Follow the process to allocate and generate your f ile.

9. Select the licenses you want to download, click Download and save the f ile to:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer

10. In the License Administration Console on the Import License File page, browse to the license f ile.

11. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

12. Click Import License.

13. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

14. Click Reread License Files to allow the license server to recognize the new file.

Users can begin using these licenses as soon as the licenses are read by the license server.

To manually obtain license files

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Allocate.

5. Follow the process to allocate and generate your f ile.

6. Select the licenses you want to download, click Download and save the f ile to a directory (remember the location where

you downloaded the f ile; you will need this location). This is the suggested location:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer

7. At the license server, copy the license f ile from the directory where it was saved to the MyFiles directory (C:\Program

Files\Citrix\Licensing\MyFiles on a 32-bit computer or C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit

computer).

T ip: Ensure that the license f ile retains the ".lic" f ile extension. Some copy processes do not recognize a f ile type for that

extension and add a ".txt" f ile extension during the copy. License f iles with the wrong f ile extension cannot be imported.

8. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

and type the following command: lmreread -c @localhost -all.

http://www.citrix.com
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Manually install a certificate used by the Simple
License Service

Sep 02, 2014

Create a certificate

To install a certificate, there are three steps:

1. Obtain a .pfx f ile, which contains the certif icate and private key. You can use one of two methods to do this.

2. Extract the certif icate and private key from the .pfx f ile.

3. Install the certif icate and private key on to the License Server.

Step 1, method 1 — Obtain the .pfx file using a domain certificate

Log on to a server in the domain, open the MMC, and follow these steps:

1. Create a directory c:\ls_cert to hold the exported .pfx f ile.

2. Add the Certif icate snap-in by selecting File > Add/Remove Snap-in > Certif icates > Computer account > Local computer.

3. In the left pane under Certif icates, right-click Personal and choose All Tasks > Request New Certif icate, and then click

Next.

4. In the Certif icate Enrollment Policy wizard, choose Active Directory Enrollment Policy, click Next, and then select the

check box next to Computer, and select Details to the right.

5. Select Properties and on the General tab, type a friendly name and description.

6. On the Subject tab, under Subject Type, choose Common name from the Type drop-down menu, type a friendly name in

the text box, click Add, and then click Apply.

7. On the Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment to the

Selected options box.

8. On the Extended Key Usage drop-down menu, add Server Authentication and Client Authentication to the Selected

options box. .

9. On the the Private Key tab and under the Key options drop-down menu, ensure that the Key size is 2048 and select the

Key Exportable check box, and then click Apply.

10. On the Certif ication Authority tab, ensure the CA check box is selected, and click OK > Enroll > Finish.

11. In the Certif icates console, select Personal > Certif icates, click the certif icate you built, select All Tasks > Export > Next,

and select the Yes, Export the Private Key radio button and Next.

12. Under Personal Information Exchange –  PKCS #12(.PFX), select the check box to include all certif icates, click Next, create

a password, and click Next.

13. Click Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to f inish.

Step 1, method 2 — Obtain the .pfx file sending a request to a Certificate Authority (CA)

These steps might vary based on your Certificate Authority.

1. Log on to the License Server, open the MMC, and follow these steps:

1. Add the Certif icate snap-in by selecting File > Add/Remove Snap-in > Certif icates > Computer account > Local

computer.

2. In the left pane under Certif icates, right-click Personal and choose All Tasks > Advance Operations > Create Custom

Request, and click Next.
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3. On the Custom request screen, choose (No template) CNG key from the drop-down menu and PKCS#10 for the

Request format, and click Next.

4. On the Certif icate Information screen, choose Details and click Properties.

5. On the General tab, type a friendly name and description.

6. On the Subject tab, under Subject name, choose Common name and type a value in the text box.

7. On the Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment.

8. On the Extensions tab, choose Enhanced Key usage from the drop-down menu, add Server Authentication and Client

Authentication.

9. On the Private Key tab, choose RSA, Microsoft Software Key Storage Provider (the default) and from the drop-down

menu choose Key options and 2048 for the Key size and Make private key exportable.

10. Save the f ile to a .req f ile, submit the .req f ile to a Certif icate Authority (CA), and save the .cer f ile.

2. In the MMC, select Certif icates > Personal > Certif icates and right-click All Tasks > Import. In the Import wizard, select

the .cer f ile.

3. Create a directory c:\ls_cert to hold the exported .pfx f ile.

4. In the Certif icates console, select Personal > Certif icates, click the certif icate you just imported, select All Tasks > Export

> Next, and select the Yes, Export the Private Key radio button and Next.

5. Under Personal Information Exchange –  PKCS #12(.PFX), select the check box to include all certif icates, click Next, create

a password, and then click Next.

6. Click Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to f inish.

Step 2 — Extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key from a .pfx file.

Important: The version of OpenSSL shipped with the License Server does not support extracting certif icates and private
keys. You can download OpenSSL for Windows at https://www.openssl.org/community/binaries.html. Citrix recommends
installing OpenSSL on a separate workstation to perform these steps:
1. Navigate to the <openssl directory>\bin folder.

2. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.crt -nokeys
Note: The License Server uses only the .crt certif icate format.

3. Type the password created during the export process (password).

4. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.key -nocerts –nodes
5. Type the password created during the export process (password).

Step 3 — Install the .crt and .key files on the License Server

1. Copy the server.crt and server.key created above to cd \program fi les
(x86)\citrix\l icensing\WebServicesForLicensing\Apache\conf\

2. Restart the Simple License Service.

https://www.openssl.org/community/binaries.html
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Upgrade

Mar 16, 2015

Each time you upgrade your Citrix product, you should also upgrade the Citrix License Server. Each time a new license server
is released, it may contain better security, f ixes to known issues, and so on. In some cases, new versions of the Citrix
product will not work with older versions of the license server.
Note: New versions of the license server are compatible with older versions of the product.
If  you are a current Citrix Subscription Advantage member, you are eligible to version upgrade to the latest release of Citrix

products and upgrade your existing licenses to the license system used by these products.

Version Upgrade means the movement from any previous version of a product to the newest version of the product (for

example, moving from XenDesktop 5.6 to XenDesktop 7.0).

Edition Upgrade means the purchase of a higher edition level of a product (for example, you currently have Enterprise

Edition and you purchase an upgrade to Platinum Edition).

Upgrade the license server

Citrix recommends that you install the newest license server. The new license server is backward compatible and will work

with older products and license files; however, new products require the newest license server to check out licenses

correctly. You can install or upgrade the latest version from the Citrix Web site (Downloads page).

Upgrade your licensing components before upgrading your product, if  necessary. Uninstall any versions of Citrix Licensing

older than version 11.3.

Unsure which version of the license server you have? See Ensure you have the latest license server.

For information about system requirements, see System requirements.

Note: If  you installed your License Server without successfully configuring it with the post installation License Server
Configuration tool, any subsequent License Server upgrades fail.
To upgrade the license server:

1. From your license server, open the media for your product. You can also f ind the license components download on the

Citrix Web site (Downloads page).

2. If  you do not see Setup, use Windows Explorer to open Autorun.exe.

3. Navigate through the setup wizard screens to Citrix Licensing and follow the instructions.

Upgrade licenses for your edition

If  you decide to run a higher edition of a Citrix product (for example, XenDesktop Enterprise to Platinum), you must

purchase an upgrade license and add it to the license server. You will also need to change the product edition setting in the

product’s user interface. Citrix recommends that you plan to change the product edition setting during a time when there

are not many connections to the affected servers or that you plan to redirect connections to another computer. When

you change the product edition setting, you must restart the product server for changes to take effect. See the product’s

documentation for changing the edition setting. If  you add the upgrade license to the license server before you set the

edition to the new edition, the Citrix product stops accepting new connections.

Note: Licenses from old product editions appear on the Dashboard of the License Administration Console even though
they are no longer valid. If  you do not remove obsolete and/or unnecessary license allocations, you might see persistent

http://www.citrix.com/English/ss/downloads/index.asp
http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-version.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-licensing-prerequisites.html
http://www.citrix.com/English/ss/downloads/index.asp
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alerts regarding the Subscription Advantage expiration dates of these licenses. You cannot turn these alerts off . The only
impact of leaving obsolete license allocations on license servers is that you will continue to receive these alerts. If  you want
to remove the licenses, see Delete License Files.
To upgrade edition licenses:

1. From a Web browser, go to http://www.citrix.com.

2. Click Log In and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Upgrade.

5. Follow the site's options and instructions for upgrading your product edition licenses.

6. Either download or order new media. An email message provides you with instructions to return to citrix.com to allocate

or receive additional feature licenses.

7. Log on to www.citrix.com to allocate your licenses, generate a license f ile, download the license f ile to your license

server, and reread the f ile.

http://docs.citrix.com/en-us/licensing/11-11-1/lic-license-files/lic-lf-delete-t.html
http://www.citrix.com
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Types

Mar 16, 2015

Your product uses one of the following types of licenses (some products allow you to choose more than one type). It is

important that you are aware of which types of licenses your company has purchased and how they are consumed. This

ensures that you do not run out of licenses. The license types are:

User/Device licenses

With XenDesktop 5 Service Pack 1 or later and XenApp 6.5 or later, the license server can assign licenses to a user or a

device and monitor license consumption. When assigned to a user, the license allows access from an unlimited number of

devices. When assigned to a device, the license allows access from the device by an unlimited number of users.

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of XenDesktop.

Use this type of license for shared devices, such as classroom or hospital.

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the

user to connect to their desktops and applications with multiple devices, such as desktop computer, laptop, netbook,

smartphone, or thin client. A licensed user can connect to multiple instances of XenDesktop concurrently.

The license server determines how to minimize license consumption based on the users and devices connected. The license

server optimizes every 5 seconds until there are 5000 uses on distinct pairs (user/device) checked out. At 5000 uses

optimization occurs every 5 minutes, which might delay status information until the next optimization.

Examples of uses on pairs:

Optimization occurs every 5 seconds for 1-4999 uses and every 5 minutes for 5000 or more uses.

5000 users * 1 device each = 5000

5000 devices * 1 user each = 5000

2500 users * 2 devices each = 5000

When users or devices connect to an application or desktop, they consume a license for the 90 day license assignment

period. The assignment period begins when a connection is made, is renewed to the full 90 days during the life of the

connection, and expires (allowing reassignment) 90 days after the last connection terminates (logs off  or disconnects). If

you have to manually end a license assignment before the 90 day period elapses (for example, an employee consuming a

User license leaves the company), use the udadmin command line tool.

Concurrent licenses

This type of license is not tied to a specific user. When a user launches a product, the product requests the license and it is

checked out to the specific computer or device that the user is using. When the user logs off  or disconnects from the

session, the license is checked back in and is available for another user. Using this logic, keep the following scenarios in mind:

Multiple sessions at different computers use multiple licenses. Each time a user launches a Citrix session from a different

computer or device, a license is checked out until the user closes the session at that computer or device (at which point

the license is checked back in). For example, if  a user launches a session from one computer and then launches another

from another computer (before closing the session on the f irst), two licenses are checked out.
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Because, license servers do not communicate with each other, if  you are running multiple license servers you may

consume more than one license (for example, with load balancing). If  you are using load balancing, Citrix recommends

that the product servers point to the same license server.

Different editions consume different licenses. If  a user connects to an application published on a computer running

Advanced edition and then uses the same client to connect to an application published on a computer running Enterprise

edition, two licenses are consumed.

Only one license is consumed when a user makes multiple connections from a single device to different product servers

configured as the same edition and pointing to the same license server.

When a user connects from a single device to two product servers that are the same edition but different versions, one

or two licenses might be consumed based on the order in which the user makes the connections. For example, the two

servers are XenApp 6.0 and XenApp 6.5:

The user connects to XenApp 6.0 f irst - Two licenses might be consumed - An older license f irst and then a newer

license.

The user connects to XenApp 6.5 f irst - Only one license is consumed.

RDP connections consume a license (RDP connections to a console do not consume a license).

Per user licenses (Only user licenses - not the same as User/Device licenses)

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the

user to connect to their desktops and applications with multiple devices, such as desktop computer, laptop, netbook,

smartphone, or thin client. A licensed user can connect to multiple instances of a product concurrently. When users connect

to an application or desktop, they consume a license for the 90 day license assignment period.

Per device licenses (Only device licenses - not the same as User/Device licenses)

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of a product.

Use this type of license for shared devices, such as classroom or hospital. It allows an unlimited number of users per device.

When devices connect to an application or desktop, they consume a license for the 90 day license assignment period.

Per socket licenses

Licenses are consumed per CPU socket actually used by a CPU and cores are not counted. For example, if  a computer with

two CPU sockets has only one CPU, only one license is used. In another example, if  that same computer with two sockets

has two CPUs, each with a quad core, only two licenses are used.

Named user licenses

When a product requests a license, it is checked out to the user until a preconfigured period of time expires. This type of

check-out is not tied to a computer or device; once the license is checked out, the user can run multiple sessions on

different computers without checking out more licenses.
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Manage

Mar 16, 2015

The License Administration Console lets you manage and monitor your Citrix licenses through a Web browser.

Use the Dashboard to:

Monitor licenses, license activity, and alerts

Use the Administration area to:

Administer licenses

Configure console users

Configure alerts

Import licenses

Log license management activities

Secure the console server

View system information

Toggle between the Dashboard and Administration views from links in the top right area of the console. Access to the

Administration area requires administration privileges and is password-protected.

To open the console on a Windows computer

To open the License Administration Console on the computer on which it is installed:

From the Start menu, select All Programs > Citrix > License Administration Console.

To open the console on a remote server or cluster

Navigate your browser to one of the following URL options:

http://license server name:web service port

http://cluster name:web service port

http://IP:web service port

where:

license server name is the name of your license server

cluster name is the name of a cluster containing the license server

IP is the IP address of the license server

web service port is the port number for the console's Web service

The default Web service port for the console is 8082.

http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-dashboard.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-vendor-daemon.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-users.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-alertconfig.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-import-licenses.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-logging.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-secure-console.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview/lic-lmadmin-systeminfo.html
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Monitor licenses and alerts

Jan 15, 2013

Use the Dashboard to monitor your license activity. The Dashboard is the default view when you open the License
Administration Console.

License status at a glance

The Dashboard presents a synopsis of your licenses:

Name Description

Product Product, edition, and type of license

SA Date The Subscription Advantage membership expiration date for the product license

In Use
(Available)

The number of licenses currently in use, followed by the total number available for use

Expiration The date the license expires

License Type The type of license, such as concurrent user or system licenses

Hosts The Hosts link appears when licenses are checked out and links to a list of the host names with
licenses in use

About alerts

Dashboard alerts are triggered by licensing events such as the license server stopping or the expiration of a Subscription

Advantage membership. You configure alerts in the Administration area. The list of displayed alerts is updated when the

Dashboard page is reloaded or refreshed.

Alerts about concurrent licenses are tested and triggered at one minute intervals. The "Vendor Daemon Down" alert is

triggered immediately.

There are two categories of alerts:

Critical alerts

Dashboard
Alert

Administration
Name

Triggering Event

The vendor
daemon has
stopped

Vendor daemon
down

The license server stops, unexpectedly or purposely stopped by the administrator

The Out of All the concurrent licenses have been checked out
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concurrent
license has
expired

concurrent
licenses

Licenses for
product_name
have expired

Concurrent
license expired

The license has expired. Note that if  the license is not a type of license covered by
Subscription Advantage, there is no deleterious effect from being expired. For
example, the startup license and evaluation licenses are always "expired" because
they are not covered by Subscription Advantage. You can ignore this alert unless it
is for a license that shows an expired Subscription Advantage date in the
dashboard.

Subscription
Advantage
membership
expired

Subscription
Advantage
membership
expired

The Subscription Advantage membership for a concurrent license has expired

Dashboard
Alert

Administration
Name

Triggering Event

Important alerts

Name of
Alert

Triggering Event

Concurrent
threshold
exceeded

A percentage (specif ied by the administrator) of concurrent licenses have been checked out

Concurrent
license
expiring

A certain number of days (specif ied by the administrator) remains before the concurrent license expires

Subscription
Advantage
membership
expiring

A certain number of days (specif ied by the administrator) remains before the Subscription Advantage
membership for a license expires. Note that if  the license is not a type of license covered by Subscription
Advantage, there is no deleterious effect from being expired. For example, the startup license and
evaluation licenses are always "expired" because they are not covered by Subscription Advantage. You
can ignore this alert unless it is for a license that shows an expired Subscription Advantage date in the
dashboard.

To view alerts

1. On the Dashboard, click the red X icon to view critical alerts or the orange ! icon to view important alerts.

2. Click items in the list to their details.

To clear alerts

Alerts are not cleared automatically when the condition changes. You must clear the alert manually to remove it from the

list.

Click the X icon next to the alert item.
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Change the display language

Jan 15, 2013

You can customize your user session by changing the console's display language. The console language reverts to the

default when you log off. You can change the display language:

Select the language you want:

When prompted during logon.

By clicking Change Display Language at the bottom left corner of the console
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Change your console password

Nov 19, 2014

You can change your License Administration Console password at any time.

Note: The Windows license server does not support changing Active Directory user and local Windows user passwords.
Active Directory users and local Windows users can change their passwords using their native operating systems. On
Windows, if  you login as a Locally Managed User and then login, you will see the "Change Password" link at the bottom
right corner. But, if  you login as a Windows Active Directory user/admin, you will not get the change password link as you
cannot change passwords for AD users. On License Server VPX, you will always have the "Change Password" link at the
bottom right corner as it does not support AD users.
1. In the bottom right corner of the console, click Change Password. If  you do not see the link, it is because you are in the

Dashboard area and you are not required to enter your credentials. Clicking the Administration option will cause the link

to appear.

2. Type your old password.

3. Type to enter and confirm your new password.

If  you forget your password, contact the console administrator to assign you a new one.
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Secure the console

Apr 17, 2013

Steps you can take to secure the License Administration Console:

Use HTTPS for the console's Web server communications

Require users to log onto the Dashboard

Specify a user session timeout

To configure a server certificate file and key file

You can use HTTPS (Hypertext Transfer Protocol Secure) to create a secure channel for console communications over your

network. If  you use HTTPS, you must have a valid server certificate. The license server already contains a self-signed

certificate, but you can create your own. If  you create your own certificate and key file, follow these steps to configure it.

1. Copy a valid server certif icate f ile and server certif icate key f ile into the \\Citrix\Licensing\LS\conf\ folder of the License

Server installation directory.

2. Click Administration and select the Server Configuration tab.

3. Click the Secure Web Server Configuration bar.

4. Select Enable HTTPS (Default 443).

5. Enter a port for the HTTPS communication.

6. Enter the location of the server certif icate f ile and the server certif icate key f ile.

7. Stop and restart the Citrix Licensing service from the services control panel of the machine running the license server.

To require users to log onto the Dashboard

You can optionally secure the Dashboard by forcing users to enter a password. The Administration area is password-
protected for all users.
1. Click Administration and select the Server Configuration tab.

2. Click the User Interface bar.

3. Select Require user to log on to view Dashboard.

To specify a session timeout

You can log out users after a specified time of inactivity, ensuring they do not leave the console unattended.

1. Click Administration and select the Server Configuration tab.

2. Click the Web Server Configuration bar.

3. For Session Timeout, enter the number of minutes that a user can remain inactive before being logged out of the

console. The maximum value is 99999 (69 days, 10 hours, 39 minutes).
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Change port numbers

Apr 03, 2013

Licensing installation sets several port numbers for communications. After installation you can use the License
Administration Console to change port numbers.

Console Web Server Port : The HTTP TCP/IP port that the Web server uses to listen for communication with clients

connecting to the License Administration Console. By default, the port is set to 8082. If  you are already using that port

number for another application, you can change it to a range between 1 and 65535. If  you use HTTPS, the default port

is 443. If  you change the port, you must stop and restart the Citrix Licensing service.

License Server Manager Port : This port number is used by the license server manager, which handles the initial

communication between the products, starts the vendor daemon, and relays check out and check in requests to the

vendor daemon. By default, this port number is 27000.

Tip: You can verify which port number is being used from the System Information tab in the Administration area.

Vendor Daemon Port : This port number is used by the Citrix vendor daemon, which is responsible for the core

operations of the license server, including license allocation. By default, this port number is 7279; however, you may need

to change it if  you have a f irewall or if  the number is already in use.

T ip: You can verify which port number is being used from the Vendor Daemon Configuration tab in the Administration

area.

When using the License Administration Console you no longer need to use the License Server Port Utility to change port

numbers. The License Server Port Utility was used to change port numbers before this functionality was developed in the

License Administration Console.

Note: The Linux kernal reserves Ports 1-1024. If  you use SSL, use port 10443, which is open in the f irewall. If  you choose a
different port for SSL, reconfigure the f irewall in the iptables.
For firewall information, see Firewall considerations.

To change the console port

1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab.

3. Click the Web Server Configuration bar.

4. In the HTTP Port f ield, modify the current port number and click Save.

5. In the host machine operating system open the Services panel and select the Citrix Licensing service.

6. Restart the Citrix Licensing service.

To change the license server port

This procedure changes the port number used by the License Server Manager (lmadmin.exe).

1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab.

3. Click the License Server Configuration bar to display the associated options.

4. Click the Use this Port radio button and type the new port number in the adjacent f ield. Click Save to save the new port

number.

5. Stop and restart the Citrix Licensing service from the services control panel of the machine running the license server.

To change the vendor daemon port

http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-fs-accessing-firewall-c.html


© 1999-2017 Citrix Systems, Inc. All rights reserved. p.34https://docs.citrix.com

1. In the top right corner of the console, click Administration.

2. Click the Vendor Daemon Configuration tab.

3. Select the Citrix vendor daemon from the table.

4. Under Vendor Daemon Port, set the new port number.

5. Click Save.

6. Stop and restart the Citrix Licensing service from the services control panel of the machine running the license server.
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Import license files

Mar 25, 2013

After generating your license file from citrix.com, you are ready to import it into the license server. A startup license is

imported during the license server installation to allow Citrix products to communicate with the license server.

1. After generating and downloading your license f ile, copy the f ile to the computer hosting the license server and console.

The default location for storing the license f ile is C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer and

C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer.

T ip: Ensure that the license f ile retains the ".lic" f ile extension. Some copy processes do not recognize a f ile type for that

extension and add a ".txt" f ile extension during the copy. License f iles with the wrong f ile extension cannot be imported.

2. Start the License Administration Console from the programs menu: Citrix > License Administration Console.

3. Start the console and click Administration.

4. Log on and click the Vendor Daemon Configuration tab.

5. Click Import License.

6. Browse to the license f ile.

7. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

8. Click Import License. The import process copies the f ile from its existing location into the MyFiles directory where it can

be read by the license server.

9. Click Administer in the Citrix vendor daemon line.

10. Click Reread License Files to allow the license server to recognize the new file.

Users can begin using these licenses as soon as the licenses are read by the license server.

To use the command line

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Allocate.

5. Follow the process to allocate and generate your f ile.

6. Select the licenses you want to download, click Download and save your license f iles. You can save the f iles directly to

the default location. The default locations where license f iles are kept are:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

7. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

and type the following command: lmreread -c @localhost -all.

http://www.citrix.com
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License administration

Jan 15, 2013

After you have imported your license files, they are administered by the Citrix vendor daemon (CITRIX.exe). The Citrix vendor

daemon is responsible for the core operations of the license server, such as tracking how many licenses are checked out

and who has them. The vendor daemon can manage all of your Citrix license files and is fully backward compatible with any

license files you have. Set properties for the vendor daemon on the Vendor Daemon Configuration page of the console.

Note: You can manage only the Citrix vendor daemon with this console.

The Vendor Daemon Configuration page allows you to import license files, configure the vendor daemon, and view logs

about license activity. Only users with Administrator privileges can view this page.

Click Administer in the vendor daemon summary grid to set these options:

Opt ionOpt ion Descript ionDescript ion

Vendor
Daemon Port
in Use

The TCP/IP port number that the vendor daemon uses for communication with products.

Stop Stops the vendor daemon, but leaves the console running. When you stop a vendor daemon, this
button changes to Start.

Start Starts the vendor daemon and reads the license f iles. This button only appears when the vendor
daemon is stopped. When you start a vendor daemon, this button changes to Stop.

Reread
License Files

Rereads the contents of the license f iles and the options f ile.

Report Log
Name

This option is not functional.

Rotate
Report Logs

This option is not functional.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.37https://docs.citrix.com

Configure console users

May 03, 2013

The License Administration Console can use License Administration users, local Windows users and groups, and Active

Directory users and groups. The Simple License Service can use local Windows users and groups and Active Directory users

and groups. The License Administration Console manages them all. These users are not connected to the computer's local

users.

The Active Directory users and groups are part of an Active Directory/network authentication system. To support Active

Directory users and groups, the Windows license server must be a member of a Microsoft Active Directory domain and must

be running the License Administration Console. Windows NT domains are not supported.

Users are configured with local roles or Active Directory roles for adding users and groups. All users are created as

administrators and can:

View the Dashboard for license activity and alerts.

Change their own password. Active Directory users and groups do not have passwords associated with them. They

contact Active Directory to be authorized and follow standard Active Directory user password policies.

Select a console display language.

View system information.

Add and delete users and expire their passwords. You can expire passwords for local users only.

Configure alerts.

Configure the license server.

Configure the vendor daemon.

Stop the license server after you have made changes to it.

Configure the administration console.

Configure, and add licenses with, the Simple License Service.

Administrators must enter user name and password when opening the Administration area. Settings in Server Configuration

allow you to optionally secure the Dashboard by requiring users to log on. If  Password Protected Dashboard is enabled ALL

users accessing the License Administration Console must log on.

What  t ypes of  account s What  t ypes of  account s are added at  inst allat ionare added at  inst allat ion

During installation of the License Administration Console, accounts are added based on machine membership. For

workgroup machine installations, computer\InstallUser and BUILTIN\Administrator are added. For Active Directory

installations, domain\InstallUser and BUILTIN\Administrator are added. You can remove any of these accounts after

installation, but ensure that there is at least one administrator.

Note: If  an "admin" user remains after an upgrade, the domain administrator can delete that user.

1. Click Administration and then the User Configuration tab.

2. Click New Users.

3. Select Locally Managed Admin from the drop-down menu.

4. Type information based on the Role chosen. Required f ields are identif ied with an asterisk (*).

User names are case sensitive, are limited to 32 characters, and cannot contain a backslash (\).

5. Optionally select the User must change password on next logon check box to force the user to create a new password.
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1. Click Administration and then the User Configuration tab.

1. If  you are adding domain users or groups, click Domain Users/groups.

2. Click New Users.

3. Select a role from the drop-down menu.

4. Type information based on the Role chosen. Required f ields are identif ied with an asterisk (*).

User names are limited to 32 characters.

Users and groups must be created as domain\user (domain can refer to a machineName) or domain\group.

Local Windows users must be created as computer\user.

For domain users, names are converted to upper case and stored. An upper case domain user name (for example,

TEST\HARVEY) can coexist with a lower case local user name (for example, test\harvey), but an upper case domain

user cannot coexist with an upper case local user name.

1. On the User Configuration page, click Edit in the line containing the user's record.

2. Type and confirm the new password.

3. Optionally select the User must change password on next logon check box to force the user to change the new

password.
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Configure licensing alerts

Jan 15, 2013

Alerts display on the Dashboard and are classified as critical or important. Administrators can select which alerts appear on

the Dashboard and set the thresholds that trigger them.

1. In the top right corner of the console, click Administration and select the Alert Configuration tab.

2. Select the alerts you want to display on the Dashboard, and for the important alerts determine the threshold to trigger

the alert.

3. Click Save.

4. By default, Subscription Advantage membership alerts are also displayed on the Dashboard. To turn on or off  these

alerts:

1. Click Vendor Daemon Configuration.

2. Select the Citrix vendor daemon.

3. Select or clear Enable Subscription Advantage membership expiration alerts for this vendor daemon.
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Improve performance by specifying thread use

Jan 15, 2013

Requests come in to the license server through a listener port. All communication must be accepted by an acceptance
thread. If  the message is accepted, a receive thread handles it and then a processing thread processes it. To improve license
server performance when receiving a large number of requests, you can configure the maximum number of receive and
processing threads to use.
When a program initiates an I/O request (an example would be a request to check-out a license), it creates and uses a

thread. The thread maintains the place and data in the program as a reference point, and once the request is complete, the

program can be re-entered at the same point. You can have many requests at the same time, depending upon how many

threads are allowed. This is called multi-threading.

The optimal values needed for acceptable license server performance are dependent on the hardware, the site
configuration, and the request volume. If  you set the limits too high and your hardware cannot support it, it will slow down
the communication. If  you set the limits too low, it will take longer for the communication to occur as the system will wait
until it can create more threads before it executes incoming requests. You should test and evaluate different values to
determine the configuration that meets your site's needs. A good starting point for a large scale deployment might be
setting the Maximum Number of License Server Manager Processing Threads to 30 and the Maximum Number of License
Server Manager Receiving Threads to 15.
There are two areas where you can specify the thread limits:

License Server

Web Server

1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab and the License Server Configuration bar.

3. Modify the Maximum Number of License Server Manager Processing Threads and Maximum Number of License Server

Manager Receiving Threads f ields (up to 999 threads).

4. Stop and restart the Citrix Licensing service from the services control panel of the machine running the license server.

Use this procedure to set the maximum number of threads that the Web server for the License Administration Console uses
to process requests. Specify a larger number if  you expect many users to simultaneously access the console.
1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab and the Web Server Configuration bar.

3. Modify the Maximum Number of Web Server Threads f ield (up to 999 threads).

4. Stop and restart the Citrix Licensing service from the services control panel of the machine running the license server.
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View system information

Oct 29, 2013

You can view system information about the license server and the system running the license server. The following

information is available by clicking the Administration option in the top right corner of the License Administration Console,

followed by the System Information tab.

NameName Descript ionDescript ion

Release Version The version of the license server.

License Server
Manager Port
Number in Use

The port number that the license server uses to communicate with the products.

Display On Windows, this is the system name or the terminal server client name (in a terminal server
environment). On UNIX, this is the X-Display name or the value returned by the ttyname() (or
comparable) function.

Host Name The name of the computer hosting the license server.

Host Domain
Name

The fully-qualif ied name of the computer hosting the license server.

IPv4 Address The IP version 4 address of the computer hosting the license server. The IPv4 address appears only
if  the computer has IPv4 enabled.

IPv6 Address The IP version 6 address used to identify the computer hosting the license server. The IPv6 address
appears only if  the computer has IPv6 enabled.

Ethernet
Address

The Ethernet address (also known as the MAC address) of the computer hosting the license server.

Local Stop
Server Allowed

Displays either yes or no. If  it is no, you cannot stop the license server using the lmdown utility or
the console. Configure this property using the -allowStopServer command line option when you run
the license server manager (lmadmin).

Remote Stop
Server Allowed

Displays either yes or no. If  it is no, you cannot stop the license server from a remote machine using
lmdown or the console.
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Logs

Mar 25, 2013

Log files are stored in:

C:\Program Files\Citrix\Licensing\LS\Logs on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\LS\Logs on a 64-bit server

LogLog File nameFile name Viewable f romViewable f rom What  it  logsWhat  it  logs

License
server log

lmadmin.log Server Configuration > Logging License server, console, and administration
activities

Vendor
daemon log

citrix.log Vendor Daemon Configuration >
Vendor Daemon Log

Licenses and license activities

Access log access.log \\Logs folder HTTP access events
Note: This log is used by support personnel for
debugging purposes only.

Web log web.log \\Logs folder Web server information
Note: This log is used by support personnel for
debugging purposes only.

Some versions of the license server (previous to 11.6.1) included a report log. The License Administration Console does not

include a report log. If  you have a legacy report log file (C:\Program Files\Citrix\Licensing\LS\reportlog.rl), it will not be

updated unless you relocate the file "reportlog.rl" to the \\Logs directory and update the options file to control it.

1. In the Administration area, on the Server Configuration page, click the Logging bar.

2. Click View log f ile.

3. To change the level of logging, select the type of information to be recorded from the Log Level dropdown list.

Note: Leave this property set to the default setting of Information unless you are instructed by support personnel to

change it to aid in troubleshooting.

This procedure displays the latest 200 lines of data in the file. You can view the entire contents of the log (citrix.log) by

opening it directly from the \\Program Files\Citrix\Licensing\LS\Logs folder.

1. In the Administration area, on the Vendor Daemon Configuration page, click the Vendor Daemon Log bar.

2. Click View log f ile.

1. In the Administration area, on the Vendor Daemon Configuration page, click the Vendor Daemon Log bar.

2. Select whether to overwrite or append to the log:

Opt ionOpt ion Descript ionDescript ion
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Overwrit eOverwrit e

VendorVendor

Daemon LogDaemon Log

When selected, this option overwrites the log when you restart the Citrix Licensing service or the

vendor daemon. If  the option is clear, the log entries are appended to the end of the f ile.

VendorVendor

Daemon LogDaemon Log

Locat ionLocat ion

Changing log location is not recommended.

Opt ionOpt ion Descript ionDescript ion

3. Click Save.

4. Click Stop under Vendor Daemon Actions.

5. Click Administer on the Vendor Daemon Configuration page and then Start under Vendor Daemon Actions.
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Set the default language

Jan 15, 2013

Administrators can change the default language of the License Administration Console display. The default applies to all
console users. Available languages include:

Chinese (Simplif ied)

English

French

German

Japanese

Spanish

Users can set a display language for the duration of their session. The console display reverts to the default language at

the end of each user session.

1. Click Administration and choose the Server Configuration tab.

2. Click the User Interface bar.

3. From the Default Display Language drop-down list, choose a language.
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License files

Mar 16, 2015

When you install the license server, a startup license and an options file are installed automatically. To license your Citrix

products you add one or more license files. See Obtain your license files for information about adding your product licenses.

You cannot change the location of license files on the license server. License files must reside in their default location.

St art up license St art up license f ilef ile

The startup license f ile (citrix_startup.lic) is a text f ile that is used by Citrix products to communicate with the license server

using a continuous open connection. Every f ive minutes the license server and the product send a heartbeat message to

each other to verify that they are mutually communicating. If  the product and the license server have been exchanging

heartbeat messages but there is an interruption in the exchange (for example, there is a power failure), the product goes

into a grace period. The startup license does not affect your license count. Do not edit this f ile.

Note: Some Citrix products can operate in a disconnected mode (not connected to the server). These products allow a user

to check out a license and operate the product for a preconfigured period of time that is set by the administrator. In this

case, heartbeat messages are not exchanged. One example of disconnected mode is when a user checks out a Password

Manager license for a laptop, and then uses the laptop when it is not connected to the server.

You can control different aspects of your licensing operations and environment by customizing the license file.

License f ileLicense f ile

The license file is a text file that contains product licensing information as well as the license server name (or other binding

identifier), the Subscription Advantage membership renewal date (also known as the Subscription Advantage Expiration

date), the license expiration date (if  applicable), and other system information. All of this information is encrypted with a

digital signature. When you purchase a Citrix product, you go to the citrix.com Web site to download a license file. You can

have more than one license file per license server. The license file resides in the C:\Program Files\Citrix\Licensing\MyFiles

directory on a 32-bit server and the C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server. The license

server uses this file(s) to determine whether or not to grant a license to a Citrix product.

If  you need to move your license files to a server with a different hostname or Ethernet address, you cannot use the license

files that you downloaded for the old license server. Create new license files that reference the new server name by

reallocating them.

See Reallocate license files for more information.

http://docs.citrix.com/en-us/licensing/11-11-1/lic-getting-started/lic-install-license-files.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-license-files/lic-lf-return-realloc.html
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License file format

Apr 08 , 2013

Caution: Modif ications can make license f iles unusable. If  using Citrix Licensing for Windows 11.6.1 or later, you should never
need to edit license f iles. You can manage licenses and their tasks through the License Administration Console and the My
Account site.
Citrix License f iles employ the following naming convention: license_FID_XDT-PLT-UD_25-mar-2013.lic.
Note: You can change the name of the license f ile, but it must have a .lic extension.
License files are composed of lines that list specific information, such as the server name (SERVER) or quantity of licenses

(INCREMENT). These lines begin with words denoting their purpose in uppercase letters, such as VENDOR, SERVER,

INCREMENT, USE_SERVER, and so on.

The following sections provide in-depth information about the following elements of license file syntax: the SERVER line,

VENDOR line, USE_SERVER line, INCREMENT line, and UPGRADE line. While the term feature is used in the options and

license file syntax, in this document, the term product license is used whenever possible for clarity.

Example license f ile with numbers corresponding to the explanations following the example:

The SERVER Line. The SERVER line specif ies the binding identif ier (also known as the hostname) of the license server.
Caution: Do not modify the binding identif ier on the SERVER line; otherwise, the license f ile will not work.
Synt axSynt ax

SERVER this_host ether

or

SERVER this_host HOSTNAME=hostname

Paramet ersParamet ers Descript ionDescript ion

ether The MAC address of the appliance on which the license server is running. Do not edit this string.

hostname The name of the computer on which the license server is running. Do not edit this string.
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ExampleExample

SERVER this_host HOSTNAME=license_server1

The VENDOR line specifies the Citrix vendor daemon name.

Synt axSynt ax

VENDOR CITRIX [vendor_daemon_path]

FieldField Descript ionDescript ion

VENDOR CITRIX Name of the Citrix vendor daemon. Do not edit this name.

vendor_daemon_path Path to the executable for the Citrix vendor daemon. Citrix recommends that you do not

change this path.

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or more INCREMENT

lines. Each INCREMENT line makes up a user-specified allocation of product and license (users, connections) counts..

Each increment line contains a signature based on the data in that line, the hostids specif ied in the SERVER line(s), and data
chosen by Citrix. INCREMENT lines use a backslash ( \ ) to wrap long lines of text.
Synt axSynt ax

INCREMENT feature vendor SA_expiry_date exp_date num_lic \ 
  SIGN=sign [optional_attributes]
Caution: Do not modify the six f ields after the INCREMENT line keyword; they are required and have a f ixed order.

The following table explains these f ields in the order they appear:

F ieldField Descript ionDescript ion

feature The product license. Do not edit this line.

vendor Indicates this license is for a Citrix vendor daemon. Do not edit this line.

SA_expiry_date Indicates the date until which you are entitled to product version upgrades. If  you do not have a

Subscription Advantage membership or this is not a Subscription Advantage license, the date

indicates when you ordered or redeemed the license. Do not edit this line.

Note: If  you renewed your Subscription Advantage membership and received an upgrade license, two

dates are listed.

The f irst date is the date when the Subscription Advantage membership was originally purchased

The second date is the SA_expiry_date

Example:

INCREMENT MPS_ENT_CCU CITRIX 2005.0311 2007.0311 permanent 1000 \

See Upgrade Lines for additional information.
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exp_date Expiration date of license in the format dd-mmm-yyyy, that is, 07-may-2006. Do not edit this line.

Note: If  the exp_date f ield contains the string “permanent,” the license never expires.

num_lic Number of concurrent licenses for this product license. Do not edit this line.

SIGN=sign SIGN= signature to authenticate this INCREMENT line. Do not edit this line.

F ieldField Descript ionDescript ion

INCREMENT lines also determine the grouping of licenses in the management console. These groups are known as license

pools. The Citrix vendor daemon creates the license pools based on common attributes, such as product license or version.

When a new pool is created, the console displays and tracks this pool independently from other license pools. When two or

more attributes are different, the Citrix vendor daemon creates a new license pool.

Cit rix Cit rix At t ribut es in INCREMENT  LinesAt t ribut es in INCREMENT  Lines

INCREMENT lines can also include additional attributes from Citrix. These attributes provide information about the license,

such as the date on which it was issued or that the license is an upgrade license.

Caution: Do not modify or delete these attributes.

ExampleExample

Important items are highlighted in the above example:

The Product (license feature) appears in blue

The Citrix Subscription Advantage expiration date appears in red (Format: YYYY.MMDD)

The License (user, connection) Count appears in GREEN

Synt axSynt ax

keyword=value

The following table describes the Citrix attributes. The uppercase letters of the attributes indicate that this attribute is not

editable.

At t ribut eAt t ribut e Descript ionDescript ion

DUP_GROUP=V This attribute allows license sharing for the same client device.

ISSUED=dd-mmm-yyyy Date issued.

ISSUER="..." Issuer of the license.

NOTICE="..." Your company’s name.

SN=serial_num A number that is used to identify INCREMENT lines.
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START= dd-mmm-yyyy The date from which you can use a license. The license server cannot use licenses

before their start date.

SUPERSEDE="MPS_ADV_CCU

MPS_STD_CCU ..."

This appears in the upgrade license f ile when you move to a higher product edition. If

this appears, all licenses issued before the date specif ied in ISSUED= are superseded by

this line and become ineffective.

VENDOR_STRING="..." String defined by Citrix.

At t ribut eAt t ribut e Descript ionDescript ion

Opt ional Opt ional At t ribut es in INCREMENT  LinesAt t ribut es in INCREMENT  Lines

INCREMENT lines contain several attributes that you can add, edit, or delete. You can add attributes, if  desired. For

example, you can insert an asset tag or a purchase order number beside each license in a f ile. Likewise, you can add

attributes that indicate a specif ic group of licenses is dedicated for a department in your organization.

Some of these attributes may be inserted by Citrix or your Value Added Reseller.

Optional attributes are listed in the table that follows. Like the Citrix-specif ic attributes, the optional attributes have a

keyword=value syntax where keyword is in lowercase. You can tell the difference between optional and required attributes

by the case of the letters: optional attributes have lowercase letters.

At t ribut eAt t ribut e Descript ionDescript ion

asset_info= "..." Additional information you can add for asset management

dist_info= "..." Additional information provided by the software distributor

user_info= "..." Additional information provided by the license administrator

vendor_info= "..." Additional information provided by Citrix

An UPGRADE line indicates the date when a Subscription Advantage membership was renewed and the date it expires.
Caution: Do not modify this line.
Synt axSynt ax

UPGRADE feature CITRIX from_Subscription_Advantage_date 
to_Subscription_Advantage_renewal_date 
exp_date num_lic \ 
[options ... ] SIGN=sign
All the data is the same as for an INCREMENT line, with the addition of the from_Subscription_Advantage_date f ield. An

UPGRADE line removes up to the number of licenses specif ied from any old version (>= from_Subscription_Advantage_date)

and creates a new version with that same number of licenses.

Example 1Example 1

For example, the following lines renew the ABCD Corporation’s Subscription Advantage membership for 1000

MPS_ENT_CCU licenses for one year (until March 11, 2006):
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 INCREMENT MPS_ENT_CCU CITRIX 2005.0311 permanent 1000 \ 
 VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ 
 DUP_GROUP=V ISSUED=12-Mar-2004 NOTICE="ABCD Corporation" \ 
 SN=LA-0000150712-12345:123 START=11-mar-2004 SIGN="1234567"
UPGRADE MPS_ENT_CCU CITRIX 2005.0311 2006.0311 permanent 1000 \ 
 VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ 
 DUP_GROUP=V ISSUED=12-Mar-2005 NOTICE="ABCD Corporation" \ 
 SN=RE-0000164638-12345:123 START=11-mar-2005 SIGN="1234567"
Example 2Example 2

For example, the following lines renew the ABCD Corporation’s Subscription Advantage membership for 1000

MPS_ENT_CCU licenses for one year (until March 11, 2006):

  
 INCREMENT MPS_ENT_CCU CITRIX 2005.0311 permanent 1000 \ 
 VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ 
 DUP_GROUP=V ISSUED=12-Mar-2004 NOTICE="ABCD Corporation" \ 
 SN=LA-0000150712-12345:123 START=11-mar-2004 SIGN="1234567"
UPGRADE MPS_ENT_CCU CITRIX 2005.0311 2006.0311 permanent 1000 \ 
 VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ 
 DUP_GROUP=V ISSUED=12-Mar-2005 NOTICE="ABCD Corporation" \ 
 SN=RE-0000164638-12345:123 START=11-mar-2005 SIGN="1234567"
An UPGRADE line applies to the closest preceding INCREMENT line with a Subscription Advantage date that is greater than

or equal to from_Subscription_Advantage_date, and less than to_Subscription_Advantage_renewal_date.

Upgrade lines use a continuation character ( \ ) to break up long lines. When using license f iles with an UPGRADE line, you

must keep the license f iles with the original INCREMENT lines in the same folder.
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Reallocate license files

Apr 08 , 2013

License files run only on the license server or hardware appliance that was specified when they were generated. If  you

change the binding identifier of a server or appliance hosting license files, you must reallocate license files so that they

match the new binding identifier.

The binding identifier is the information in the license file that identifies the machine where the license file is hosted. The

binding identifier is usually the license server hostname, but it can also be a hardware appliance name, Ethernet address

(MAC address), or FQDN.

Situations in which you might need to reallocate a license f ile:
You rename your license server

You want to move your license f iles to a server with a different name

You used some licenses initially to create a test environment and now you want to reuse those licenses on a different

license server

Designating a new binding identifier when you reallocate licenses does not consume additional licenses. The process

changes only the binding identifier for the licenses.

1. Start the console (Start > All Programs > Citrix > License Administration Console).

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Reallocate.

8. Select the check boxes preceding the licenses you want to reallocate, click Continue.

9. On the pages that follow, follow the instructions to select the licenses to be reallocated into the new file (and

associated with a new license server) and download the license f ile.

10. Save the f iles to a location such as your desktop (remember the name of the f iles and location where you downloaded

the f ile; you will need this location). You can save the f ile directly to the default location. The default locations for

license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

11. In the License Administration Console on the Import License File page, browse to the license f ile.

12. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

13. Click Import License.

14. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

15. Click Reread License Files to allow the license server to recognize the new file.

1. From a Web browser, go to http://www.citrix.com.

http://www.citrix.com
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2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Reallocate.

5. Select the check box preceding the licenses you want to reallocate, then click Continue.

6. On the pages that follow, follow the instructions to select the licenses to be reallocated into the new file (and

associated with a new license server) and download the license f ile.

7. Save the f ile to a location such as your desktop (remember the name of the f ile and location where you downloaded the

file; you will need this location). You can save the f ile directly to the default location. The default locations for license

files:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

8. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

and type the following command: lmreread -c @localhost -all.
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Replace (redownload) license files

Apr 08 , 2013

Replacement license files are copies of license files you previously generated. You might need to download replacement files

if  you corrupt or delete a license file. You can choose how to redownload the licenses by using the By Host or By Allocation

tabs.

1. Start the console (Start > All Programs > Citrix > License Administration Console).

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Redownload.

8. Click Select All to select all items on all pages, click the Page check box to select all items on that page, or select the

check boxes preceding the licenses that you want to download.

9. Click Download and save the f iles to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

10. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

11. Click Import License.

12. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

13. Click Reread License Files to allow the license server to recognize the new file.

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. From the main menu, select Redownload.

4. Click Select All to select all items on all pages, click the Page check box to select all items on that page, or select the

check boxes preceding the licenses that you want to download.

5. Click Download and save the f ile to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

6. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

and type the following command: lmreread -c @localhost -all

http://www.citrix.com
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Combine license files

Apr 08 , 2013

If  you are accumulating a lot of license files on a license server, you can combine the licenses into one license file. License

files can accumulate when you:

Purchase additional licenses

Renew your Subscription Advantage membership

Tip: Back up and then delete the old license f iles from the license server before replacing them with the new files.

1. Start the console (Start > All Programs > Citrix > License Administration Console).

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Redownload.

8. Use the By Host tab (to automatically combine all specif ied licenses allocated to a host ID into single line item) and click

Select All to select all items on all pages, click the Page check box to select all items on that page, or select the check

boxes preceding the licenses that you want to download.

9. Click Download and save the f iles to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

10. In the License Administration Console on the Import License File page, browse to the license f ile.

11. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

12. Click Import License.

13. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

14. Click Reread License Files to allow the license server to recognize the new file.

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Redownload.

5. Use the By Host tab (to automatically combine all specif ied licenses allocated to a host ID into single line item) and click

Select All to select all items on all pages, click the Page check box to select all items on that page, or select the check

boxes preceding the licenses that you want to download.

6. Click Download and save the f iles to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

http://www.citrix.com
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C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

7. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

and type the following command: lmreread -c @localhost -all
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Delete license files

Dec 14 , 2016

When you upgrade your edition (for example, Advanced to Enterprise, or Enterprise to Platinum) you receive new Citrix

product licenses that you can allocate to one or many Citrix License Servers through license files created at

citrix.com. Rescinded licenses must be removed from license servers within ninety (90) days of new license purchase.

Removing the licenses enables:

License asset management

License compliance

Remove unnecessary alerts from appearing in the management console

Considerations when deleting f iles:
Incorrect removal of license f iles could inadvertently lower the total licenses available.

Place any new license f iles on the license server prior to deleting any licenses.

Remove a license f ile only when all INCREMENT lines in the f ile are obsolete or unnecessary. For example, every

increment line has been replaced with a new license as a result of an upgrade.

If  you used the License Administration Console to add license f iles, you have to update the console UI for any deleted

files.

Important: Never delete the options f ile (citrix.opt) or startup license (citrix_startup.lic).
1. At the license server, open the Services panel and stop the Citrix Licensing service.

2. Open Windows Explorer and navigate to where the license f iles are stored. By default license f iles are stored in:

C :\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

3. Back up all license (.lic) f iles.

4. Using a text editor (Microsoft WordPad is recommended), open each license (.lic) f ile and identify the obsolete license

feature INCREMENT line(s).

5. Ensure all increment lines are obsolete or unnecessary. See License f ile format for information about increment lines.

6. Close the f ile and change the f ile extension from .lic to .old.

7. In the Services panel, restart the Citrix Licensing service.

If  you added license files with the console, you must update the console UI after removing those files.

1. Start the console and click Administration.

2. Log on as an administrative user and click the Vendor Daemon Configuration tab.

3. Select the Citrix vendor daemon from the list.

4. Edit the contents of License File or Directory to remove any deleted licenses and then save the configuration.

http://docs.citrix.com/en-us/licensing/11-11-1/lic-license-files/lic-lf-license-format-r.html
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Commands

Mar 16, 2015

While the License Administration Console provides an easy method of accessing many licensing features, you can also

perform licensing tasks using commands. You might use license administration commands when performing advanced

operations on the license server that are not available in the console. Such operations include diagnosing check-out

problems using lmdiag.

License administration commands are stored in:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

Ut ilit yUt ilit y Descript ionDescript ion

lmadmin Provides licensing configuration. Use the License Administration Console for licensing configuration and
administration tasks. Do not use lmadmin.

lmdiag Diagnoses license check-out problems. See lmdiag.

lmdown Gracefully shuts down the License Manager and Citrix vendor daemons (disabled by default). See lmdown.

lmhostid Reports the host ID of the server on which Citrix Licensing is running. See lmhostid.

lmreread Causes the License Manager daemon to reread the license f ile and start the Citrix vendor daemon. See
lmreread.

lmstat Displays the status of a license server. See lmstat.

lmutil Displays a list of licensing utilities or executes other commands. See lmutil.

lmver Displays version information for the licensing binaries. See lmver.

udadmin Displays all licensed users and devices and deletes specif ied licensed users and devices. This command applies
to User/Device licenses only. See udadmin.

Formatting conventions for the license administration commands:

Convent ionConvent ion Descript ionDescript ion

Bold A command or switch, such as lmstat.

http://docs.citrix.com/en-us/licensing/11-11-1/lic-lmadmin-overview.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-diag-checkout-prob-r.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-stop-daemons-r.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-check-hostid-r.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-reread-lic-r.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-status-r.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-list-utilities-r.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-lmver.html
http://docs.citrix.com/en-us/licensing/11-11-1/lic-admin-cmds-intro-c/lic-admin-cmds-list-deletes-user-device-r.html
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Italic You need to replace variables with a value; for example, in the expression:
lmstat -c license_file_list

Before you run the command you must replace license_file_list with the names of one or more license

files.

[square
brackets]

Square brackets around text indicate options that can be added to the command or that text within
the brackets needs to be replaced.

Convent ionConvent ion Descript ionDescript ion

Valid arguments for most license administration commands:

ArgumentArgument Descript ionDescript ion

-all Applies the command to all of the license servers on the network.

-c Lets you specify license f ile(s) or license server port and host name.
If  you specify the path without a license file name, the command applies to all the license files in the

directory.

For a local host: -c @localhost

For a remote license server: -c @servername

For a license server in a cluster: -c @clustername

For a specified path: -c path

For the names of one or more license files: -c license_file_list

You can enter more than one license file path by separating each path with a semicolon.

Path names that include spaces must be enclosed in double quotes.

-h License handle, as reported by lmstat -a. The license handle is a number used to identify a specif ic
checked out license.

-help Displays usage information and exits.

-s [server] Displays the status of all license f iles listed on the license server or on all license servers, if  server is not
specif ied.

-verbose Displays a longer description for all errors found.
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Diagnose checkout problems (lmdiag)

Feb 28 , 2013

lmdiag allows you to diagnose problems when a product cannot check out a license. In particular, you can test if  your

licenses are valid and if  the license server is running. When you run this utility, it attempts to check out a license.

You can also use the lmdiag utility to see if  a specific type of license is working. For instance, you can run lmdiag on your

Citrix XenApp server, Advanced edition licenses only by specifying MPS_ADV_CCU as an argument.

lmdiag -c l icense_fi le_l ist [-n] [feature[:keyword=value]]

ArgumentArgument Descript ionDescript ion

-c

license_file_list

Diagnoses the specif ied f iles. You can also use:-c @localhost or -c @server-name

-n Runs in non-interactive mode; lmdiag does not prompt for any input in this mode.

feature Limits the feedback to the specif ied feature.

keyword=value If  a license f ile contains multiple lines for a particular feature, the result is limited to the line
containing the text value. For example:
lmdiag –c @localhost MPS_ENT_CCU:HOSTID=LICSERV01
attempts a checkout on the line with the host ID “LICSERV01.”

Keyword is one of the following: VERSION, HOSTID, EXPDATE, KEY, VENDOR_STRING, ISSUER

If no feature is specified, lmdiag operates on all features in the license files in your list. lmdiag displays information about the

license, then attempts to check out each license. If  the check out succeeds, lmdiag indicates success. If  the check out fails,

lmdiag gives you the reason for the failure. lmdiag attempts to connect to each TCP/IP port on the license server. It

detects if  the port number in the license file is incorrect. lmdiag lists each TCP/IP port number that is listening, and if  -c

license_file_list is specified, diagnoses the specified files.

lmdiag does not contact the computer running the Citrix product when it attempts to check out licenses. lmdiag indicates

only if  there are problems on the license server. That is, your product cannot check out licenses because it is pointing to the

wrong license server (for example, a license server that does not have licenses for that product on it), but lmdiag does not

detect this problem. lmdiag reports that it can check out licenses when the Citrix product is pointing to the wrong license

server.
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Stop daemons (lmdown)

Feb 28 , 2013

The lmdown utility shuts down the License Manager daemon and the Citrix vendor daemon on your license server or all

license servers on your network but is disabled by default. To enable it:

1. Stop the license service.

2. Run lmadmin - allowStopServer and/or -allowRemoteStop Server.

3. Restart the license server.

lmdown -c l icense_fi le_l ist [-vendor CITRIX] [-q] [-al l]

ArgumentArgument Descript ionDescript ion

-c @localhost  

or 

-c@server

or

-c

license_file_list

Use the specif ied license f iles. Note that specifying -c license_file_list is always recommended with
lmdown. You can also use:-c @localhostor -c @server-name

-vendor
CITRIX

Shut down only the Citrix vendor daemon. The License Manager daemon continues to run.

-q Do not prompt or print a header. Otherwise lmdown asks “Are you sure? [y/n]: .”

-all If  multiple servers are specif ied, automatically shuts down all of them. -q is implied with -all.

The lmdown utility must be run on a license server. You can use -all to shut down all of the license servers on your network.

If  lmdown encounters more than one server (for example if  -c specifies a directory with many *.lic files) and -all is not

specified, the utility displays a choice of license servers to shut down. You can shut down remote license servers by using -c

and specifying the name of the license server.

Note: If  you use the Task Manager to terminate the License Manager daemon (Citrix Licensing Service), stop the lmgrd
process f irst, then stop the Citrix vendor daemon process.
To stop and restart the Citrix vendor daemon only, use lmdown -c @localhost -vendor CITRIX, then use lmreread -c

@localhost -vendor CITRIX to restart the vendor daemon.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.61https://docs.citrix.com

Check host names (lmhostid)

Feb 28 , 2013

The lmhostid utility returns the host ID of the license server. You can use the command to check the host name of your

license server. You can open a license file and compare the host name in the license file to that of your license server.

Note: Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if  there are more than one
host.

lmhostid –bindingidentifier

ArgumentArgument
(bindingident if ier)(bindingident if ier)

Descript ionDescript ion

-ether Used for product licenses that are tied to the MAC address of the appliance.

-internet Used for Windows-based Citrix product software licenses that require a TCP/IP address.

-hostname Used for Windows-based Citrix product software licenses that are tied to the hostnameof
the license server.
Note: The parameter hostname is case-sensitive and must match your license server name
exactly.
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Reread license and options files (lmreread)

Feb 28 , 2013

The lmreread utility causes the Citrix vendor daemon to reread changes to the license file and the options file. After

rereading, the Citrix vendor daemon uses the new settings and/or licenses going forward.

lmreread cannot be used remotely; run it locally on the license server.

lmreread -c l icense_fi le_l ist [-al l] [-vendor CITRIX]

ArgumentArgument Descript ionDescript ion

-c @localhost  

or

-c license_file_list

Use the specif ied license f iles.

-all If  more than one lmgrd is specif ied, instructs all License Manager daemons to reread.

-vendor CITRIX Specif ies for the Citrix vendor daemon to be restarted.

lmreread -c @localhost [-all]

lmreread -c @clustername

lmreread -c C:\Program Files\Citrix\Licensing\MyFiles\CITRIX.lic -vendor CITRIX
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Display the list of licensing utilities (lmutil)

Feb 28 , 2013

The lmutil utility displays a list of licensing utilities when used standalone. When you specify lmutil with another command, it

executes that command.

lmutil
lmutil  other_command

lmutil

Displays all the licensing utilities.

lmutil lmstat -c @localhost

Executes the lmstat command.
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Determine licensing status (lmstat)

Feb 28 , 2013

The lmstat utility helps you monitor the status of all network licensing activities and provides you with information about
license check outs, including:

The product that checked out one or more licenses

The check out data

The version of the license f ile

The license server name and port

The date the license was checked out

Information about the Citrix vendor daemon status and the license f iles

lmstat displays information that it receives from the license server. lmstat displays only one use of the license, even if  there

are multiple connections sharing that license.

lmstat [-a] [-c l icense_fi le_l ist] [-f [feature]] [-i  [feature] [-s[server] [-S [CITRIX]] [-t timeout_value]

ArgumentArgument Descript ionDescript ion

-a Displays all information.

-c @localhost or -c@server or
-c license_file_list

Uses the specif ied license f iles.

-f  [feature] Displays the products using a feature (product license). If  feature is not specif ied,
usage information for all features is displayed.

-i [feature] Displays information from the INCREMENT line for the specif ied feature (product
license) or all features if  feature is not specif ied.

-s [server] Displays status of all license f iles listed on the license server or on all license servers, if
server is not specif ied.

-S [CITRIX] Lists all product servers using the features (product licenses) served by the Citrix vendor
daemon.

-t timeout_value Sets connection time-out to timeout_value. This limits the amount of time lmstat
spends attempting to connect to the license server.

The output of lmstat -c@localhost -a looks similar to:
License server status: 27000@license_server1 
License fi les on l icense_server1: C:\Program Files\Citrix\Licensing\MyFiles\citrix_startup.l ic:  
C:\Program Files\Citrix\Licensing\MyFiles\citrixl ic_20031001094430.l ic:  
 
l icense_server1: l icense server UP (MASTER) v9.2  
 
Vendor daemon status (on l icense_server1):  
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CITRIX: UP v9.2  
 
Feature usage info:  
   Users of CITRIX: (Total of 5000 l icenses issued; Total of 1 l icense in use)  
     "CITRIX" v2002.0101, vendor: CITRIX  
     floating l icense  
       MPS mps_server1 MPS MPS_ENT_2004.0227 (v1.0)  
       (l icense_server1/27000 101), start Tue 3/16 16:59  
 
   Users of MPS_ENT_CCU: (Total of 30 l icenses issued; Total of 1 l icense in use)  
     "MPS_ENT_CCU" v2004.1201, vendor: CITRIX  
     floating l icense  
     MPS mps_server1 MPS 25fb337e:MPSCLIENT  
     (v2004.0227) (l icense_server1/27000 203), start  
     Wed 3/17 11:56
The following represents a breakdown of the information contained in the MPS_ENT_CCU line of the lmstat output:

MPS citrix_product_name The name of the Citrix product that has the license checked out.

mps_server1 hostname Computer where the Citrix product is running.

MPS display The name of the Citrix product that has the license checked out.

license_server1 server_host Computer where the license server is running.

27000 port TCP/IP port where the license server is running.

203 handle License handle. The license handle is a number used to identify a specif ic
checked out license.

start Wed 3/17
11:56

checkout_time Time that this license was f irst checked out.

Note: lmstat -c@localhost -a can potentially generate a lot of network activity in systems with many product licenses
checked out.
You can use lmstat -a to verify license check out data.
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Display versions of binaries (lmver)

Feb 28 , 2013

The lmver utility displays version information for the licensing binaries, such as the command utilities. One exception is the

lmadmin utility. To display version information for the lmadmin utility, use lmadmin -version.

Syntax

lmver binary
Example

lmver lmdiag
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Display or release licenses for users or devices
(udadmin)

Dec 16, 2014

udadmin displays the licensed users and devices and releases licenses for specified users and devices.

You can release a license for a user only when the employee is no longer associated with the company or is on an extended

leave of absence. You can release licenses for devices only when the devices are out of service.

The udadmin command line help displays usage information only in English, but you can use the command on non-English

systems.

Caution: Be aware that mass releases of licenses, prior to the automatic 90 day lease period, outside of the reasons
highlighted above might violate the Citrix End User License Agreement (EULA). Before doing so, contact Citrix.
Important: udadmin applies to User/Device licenses only and cannot be used remotely; local access to HTTP port 80 is
required.

Syntax

udadmin [-options] [-delete | -l ist ]  

Options Description

-f  featurename When used with -list or -delete, displays or releases the license for only the user or device for the
specif ied featurename.

-user username Releases the license for only the user specif ied by the username.

-device
devicename

Releases the license for only the device specif ied by the devicename.

-a Lists all features and versions installed on the license server.

Argument Description

-delete Releases the license for one user, feature, or device at a time.

-list Displays the users and devices with licenses and the time since the last update. The time to the next
update appears if  signif icant activity occurred within 15 minutes of the last report.

no
argument
or ?

Displays usage information for the udadmin command.

Examples

udadmin -list
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Displays all the users and devices.

udadmin -list -a

Lists all features, versions, counts of licenses, and the users and devices for each feature.

udadmin -f  XDT_ENT_UD -user u8.08 -delete

Releases one user from one feature.

udadmin -f  XDT_ENT_UD -device dn01.88 -delete

Releases one device from one feature.
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Subscription Advantage

Sep 04 , 2015

When you purchase a new Citrix product, your purchase includes a one-year membership in Citrix Subscription Advantage.

This membership entitles you to, among other benefits, any product updates, including major and minor releases, released

during your membership period. For example, if  you purchased XenDesktop, Enterprise edition on July 22, 2013, you are

entitled to any updates released for XenDesktop, Enterprise edition until July 21, 2014. After your initial one-year

membership period expires, you may choose to renew your Subscription Advantage membership. After paying Citrix for your

renewal, you must go to citrix.com and download a license file containing your renewal license.

Note: A Subscription Advantage membership and its associated license are distinct from your license to run the product. If
you do not renew your Subscription Advantage membership, your Citrix products do not stop working; however, you are not
entitled to any software releases after it expires.

Adding Subscription Advantage renewal files

Subscription Advantage renewal license files contain licenses, known as renewal licenses, that extend your Subscription

Advantage membership for a one-year period. These licenses are required to run any new product releases, excluding

hotfixes, that are released during your membership period.

After you download your Subscription Advantage renewal license file from citrix.com, you must add it to your license server.

Copy the Subscription Advantage renewal license files to the same directory as your existing license files and reread the

license files. By default, this location is C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server and C:\Program Files

(x86)\Citrix\Licensing\MyFiles on a 64-bit server. After you add the renewal license to your license server, the license

automatically unlocks any subsequent versions of the product released during the Subscription Advantage period.

If  you do not add the Subscription Advantage renewal licenses immediately, your Citrix products do not stop working.

However, you cannot run any new software released during your renewed membership until you have the renewal license

on your license server.

You do not need to download additional licenses when you install new versions of your products during this membership

period. If  Citrix releases a product version after your Subscription Advantage membership ends, you must renew your

Subscription Advantage membership and obtain a renewal license before you can use the new product version.

Note: When you download additional license f iles, you can delete the expired Subscription Advantage licenses; however, it is
not a requirement. You might want to keep them to make it easier to identify the upgrade that is associated with each
base license.
You can f ind out what your Subscription Advantage dates are:

In the License AdministrationConsole on the Dashboard.

Using a text editor to view the license f ile: See the Upgrade Lines section in License f ile format for information about

reading the contents of the license f ile.

Renewing only part of  your Subscription Advantage membership

If  you run products from two different releases in your environment (for example, you have a mixed XenDesktop

environment of versions 5.0 and 7.0) and you are not purchasing Subscription Advantage for all your licenses, Citrix

recommends that you separate the product licenses on two separate license servers. Subscription Advantage is applied to

the older product versions first.

For example, if  you own 200 licenses for 5.0 and you renew your Subscription Advantage membership for only 100 of those

http://docs.citrix.com/en-us/licensing/11-11-1/lic-license-files/lic-lf-license-format-r.html
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licenses, it is possible that those 100 renewal licenses, which are required for 7.0, could be consumed by connections to

computers running 5.0. 

To separate your licenses (two different licenses on two different servers)

1. Select a second server and install the license server software.

2. Go to citrix.com to reallocate your original licenses (these are the licenses contained in your current license f ile on the

original license server) and then reallocate the licenses into two new files:

Allocate 5.0 licenses to create a license f ile for your f irst server

Allocate 7.0 licenses to create another license f ile for the second server

3. Generate and download your Subscription Advantage f iles and then copy them to the server to which you want them

applied.

4. Point all computers to the license server running the version of the Citrix product you want them to use. For information

about pointing your Citrix product server to the license server, see your Citrix product’s administrator guide.
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Clustered license servers

Mar 16, 2015

Cluster servers are groups of computers that are combined to increase availability, reliability, and scalability. Microsoft

clustering functionality exists in Windows Server 2008 and Windows Server 2012. Clustering the license server lets users

continue working during failure situations without interrupting their access to critical applications. When the active node in

a cluster-enabled license server suffers from hardware failure, failover occurs automatically. Resources are available again in

a few seconds to a few minutes.

A typical cluster configuration has, at a minimum, one active and one passive (backup) server. When the active server in a

cluster fails, the ownership of the resources in the cluster are transferred to the backup (passive) server. Typically, users

cannot detect when one server in a cluster fails over to another.

When the active node of a clustered license server fails, there is no impact on users connected to the Citrix product. The

product may briefly enter the licensing grace period and an event may be written in the product’s event log.

Citrix Licensing supports clustering the license server with two servers in a cluster and a shared drive. That is, you can cluster

the license server in a two-node Microsoft Cluster in an Active/Passive Microsoft clustering configuration.

Citrix Licensing in a cluster

Like most clusters, a private network is used to send heartbeats, commands, and state information between the nodes of

the cluster. If  the connection is interrupted, the nodes try to reconnect by the private network first, then the public

network. The following diagram illustrates a cluster-enabled licensing deployment:

Figure 1. Communications in a clustered licensing environment
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Only one node can use the resources in a cluster at any given time. If  you already deployed Citrix Licensing and you want to
migrate your deployment to a cluster-enabled server, keep the following points in mind:

Because you already generated license f iles that reference a specif ic server name, you must either give the cluster the

same name as the original license server or rehost your license f iles with the new name of the license server cluster.

Host names in license f iles are case-sensitive; therefore, the cluster names must be the same case as the host names in

the license f ile. If  they are not, you must rehost your license f iles with the correct capitalization of the names. You can

use the Failover Cluster Manager to ensure the cluster name matches the host name specif ied in the license f ile. Note:

Cluster and host name case is not an issue if  you use Studio in XenDesktop or the Simple License Service (from the Start

menu on your license server) to download your licenses.

You must point all product installations (for example, servers running Citrix XenDesktop) serviced by the old license server

to the new license server cluster. Change product communication settings so that they use the name of the cluster as

the license server name. For information about editing product-side communication settings, see the product’s

documentation.

Opening the console or running commands

All licensing administration features available in standard deployments are also available on clustered license servers,

including the management console and the ability to run license administration commands.

Open the License Administration Console in a cluster by browsing to:

http://clustername:web service port
Where clustername is the name of the cluster and web service port is the port number for console communications (the

default port number is 8082).
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You can run many license administration commands using the argument -c @clustername to specify the location of the

license file(s) in the cluster. For example:

lmreread -c @clustername
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Requirements for clustered license servers

Mar 13, 2013

The following list outlines the requirements for setting up a license server in a Microsoft Cluster:
Before configuring Citrix Licensing for Microsoft clustering, you must have a fully-functional active/passive cluster

environment. Citrix Licensing does not support active/active clusters.

To cluster the license server, you must follow the following cluster requirements in addition to any requirements from

Microsoft for hardware and clustering in general.

You must install licensing on the cluster by starting the licensing setup program using a command line.

When you install Citrix Licensing on a cluster, you must specify the name of the cluster when prompted for the name of

the license server during product installation.

Citrix recommends that you use identical license server hardware for both nodes in the cluster. In particular, Citrix

recommends two network adapters on each node and the servers have one drive configured as a shared drive.

Each node should have two network adapters— one for connection to the public network and the other for the node-

to-node private cluster network. Citrix does not support using one network adapter for both connections.

The public and the private IP address must be on different subnets because the Cluster Service will recognize only one

network interface per subnet.

A name resolution method, such as DNS, WINS, HOSTS, or LMHOSTS, is necessary to resolve the cluster name.

Both servers that form the cluster must be in the same domain.

The hostname of both servers must be ALL UPPERCASE.

Set static IP addresses for the private network connector.

When you generate a license f ile at citrix.com, use the name of the license server cluster when prompted for the host

name.

After you download a license f ile, you must copy it to the F:\Program Files\Citrix\Licensing\MyFiles folder (where F: is the

shared drive for the cluster) on the license server and reread it. Alternatively, use the License Administration Console to

download, copy, and reread the f ile.

Important: Citrix recommends setting static IP addresses for all network adapters in the cluster, both private and public. If
IP addresses are obtained by Dynamic Host Configuration Protocol (DHCP), access to cluster nodes could become
unavailable if  the DHCP server goes down. If  you must use DHCP for your public network adapter, use long lease periods to
assure that the dynamically assigned lease address remains valid even if  the DHCP service is temporarily lost or perform a
DHCP reservation.
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Overview of the clustering process

Mar 13, 2013

The following steps describe the overall process involved in installing and configuring licensing on a cluster-enabled server.
These steps assume you configured the clustering on the hardware on which you intend to install the license server.
1. Ensure that the f irst node has control of the cluster resources.

2. On the f irst node of the cluster, start the Citrix Licensing installation from the command-line and install it on the f irst

node to the shared cluster drive (not the quorum drive).

3. Move the resources from the active node in the cluster to the second node.

4. Install the license server on the second node to the same shared location as the f irst node.

5. Obtain license f iles that specify the cluster name of the license server as the host name. After obtaining license f iles, you

must add them to the license server and then reread them.

6. Configure your Citrix product to use the cluster name— not the node name— of the license server cluster.

Note: When a clustered license server fails over, the cluster service renames the lmgrd_debug.log to the name of the node
that previously hosted the services. Then it starts the services on the new active node and creates a new lmgrd_debug.log.
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Install licensing on a clustered-enabled server

Apr 03, 2013

The following drive letters and paths/variables are used in this procedure:

D is the drive for your product media.

C is the local hard drive on the specif ied node.

F is the cluster shared drive resource. (This is the installation drive. That is, the place where installation f iles used by both

nodes are stored.)

CTX_CLUSTER_RESOURCE_DLL_PATH is the location where the cluster resource DLL executable is stored. Store this f ile

locally on each cluster node. Use this msiexec argument only for clustering.

REGISTER_CTX_LS_CLUSTERING is either "no" for cluster node 1 or "yes" for cluster node 2. Use this msiexec argument

only for clustering.

1. Ensure that the cluster IP address, cluster name, and a shared disk are configured as cluster resources and that all the

cluster resources are owned by the f irst node of the cluster.

2. Open and run the command prompt as an administrator. In the f irst node of the cluster, run the following:

msiexec /i  D:\Licensing\ctx_licensing.msi 
CTX_CLUSTER_RESOURCE_DLL_PATH="C:\ctxlic" 
REGISTER_CTX_LS_CLUSTERING="No" /l*v "C:\install .log"

3. In the setup wizard accept the license agreement.

4. On the page where you specify the destination folder, set the drive letter to correspond with the cluster shared drive. By

default, the licensing components are installed in F:\Program Files\Citrix\Licensing.

5. On the License Server Configuration page, accept the default port numbers or, if  the numbers are already in use, enter

alternate numbers. If  needed, you can modify port numbers after the installation through the License Administration

Console.

6. Using the Cluster Administrator, make the second node in the cluster active.

7. In node 2 of the cluster, open and run the command prompt as an administrator. Run the following (For node 2, you will

be typing Yes to register the clustering service):

msiexec /i  D:\Licensing\ctx_licensing.msi 
CTX_CLUSTER_RESOURCE_DLL_PATH=“C:\ctxlic” 
REGISTER_CTX_LS_CLUSTERING=“Yes” /l*v “C:\install .log”
Note that in this step REGISTER_CTX_LS_CLUSTERING is changed to Yes.

8. Repeat Steps 3 to 5.

9. Import your license f iles using the console.

1. Open the License Administration Console from http://clustername:web service port, where clustername is the name

of the cluster and web service port is the port number for the console Web server (8082 by default).

2. Click Administration and choose the Vendor Daemon Configuration tab.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Allocate.

8. Follow the process to allocate and generate your f ile. Select the licenses you want to download, click Download and

save generated license f iles to the shared drive of the cluster: F:\Program Files\Citrix\Licensing\MyFiles\.
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9. In the License Administration Console on the Import License File page, browse to the license f ile.

10. Select Overwrite License File on License Server.

11. Click Import License.

10. Reread the license f iles.

1. Choose the Vendor Daemon Configuration tab.

2. Click Administer in the CITRIX vendor daemon line.

3. Click Reread License Files.
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Upgrade a clustered license server

Apr 03, 2013

The following drive letters and paths/variables are used in this procedure:

D is the drive for your product media.

C is the local hard drive on the specif ied node.

F is the cluster shared drive resource. (This is the installation drive. That is, the place where installation f iles used by both

nodes are stored.)

CTX_CLUSTER_RESOURCE_DLL_PATH is the location where the cluster resource DLL executable is stored. Store this f ile

locally on each cluster node. Use this msiexec argument only for clustering.

REGISTER_CTX_LS_CLUSTERING is either "no" for cluster node 1 or "yes" for cluster node 2. Use this msiexec argument

only for clustering.

1. Using the Cluster Administrator, make the f irst node in the cluster active.

2. From a command line, run the following:

msiexec /i  D:\Licensing\ctx_licensing.msi 
CTX_CLUSTER_RESOURCE_DLL_PATH="C:\ctxlic" 
REGISTER_CTX_LS_CLUSTERING="No" /l*v "C:\install .log"
Note: The resource DLL should be stored locally for each node in the cluster. This is the only f ile that should be stored on

each cluster node.

Setup will detect the existing installation and will upgrade the f irst node.

3. On the License Server Configuration page, accept the default port numbers, or, if  the numbers are already in use, enter

alternate numbers. If  needed, you can modify port numbers after the installation through the License Administration

Console.

4. Using the Cluster Administrator, make the second node in the cluster active.

5. From a command-line on node 2, run the following (For node 2, you will be typing Yes to register the cluster services):

msiexec /i  D:\Licensing\ctx_licensing.msi 
CTX_CLUSTER_RESOURCE_DLL_PATH=“C:\ctxlic” 
REGISTER_CTX_LS_CLUSTERING=“Yes” /l*v “C:\install .log”
Note that in this step REGISTER_CTX_LS_CLUSTERING is changed to Yes.

Setup will detect the existing installation and will upgrade the second node.
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Uninstall a clustered license server

Apr 03, 2013

Uninstall licensing from a clustered license server using the Control Panel > Programs and Features option from the active
node.
1. From the f irst node in the cluster, launch Control Panel > Programs and Features .

2. Remove Citrix Licensing.

3. Using the Cluster Administrator, make the second node active and launch Control Panel > Programs and Features.

4. Remove Citrix Licensing from the second node.

5. Delete the remaining f iles from the shared drive.

Note: The uninstallation process does not remove the license f iles and options f ile from the shared drive.
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Troubleshoot cluster-enabled license servers

Apr 19, 2013

Note: If  any of the licensing services fail to start, the cluster detects that licensing is off line and attempts to restart the
service three times (by default). If  these attempts are unsuccessful, fail-over to the next node is initiated and the cluster
attempts to start the services on the second node. If  the attempts fail on the second server, the process may enter into an
infinite loop. In this case, the computers running Citrix products fall into the grace period. During the grace period, client
connections are not affected.
When troubleshooting a cluster-enabled license server, try the following:

If  you move the resources to the other node, do you still see the issue?

Did you check the Use Network Name for Computer Name check box in the Microsoft Cluster Server? See

http://support.microsoft.com/kb/198893.

For Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012:

1. In the Failover Cluster Management window, from the left pane, select the cluster. In the middle pane, the summary

information for the cluster appears.

2. Click the Cluster Core Resources title to expand the section.

3. Verify that the cluster resources are all online (green arrow).

http://support.microsoft.com/kb/198893


© 1999-2017 Citrix Systems, Inc. All rights reserved. p.81https://docs.citrix.com

Back up

Mar 16, 2015

Depending on how crucial the applications associated with your licenses are, you may want to create backup license

servers. Although Citrix stores backup copies of your licenses, downloading many replacement licenses can be time-

consuming. You can either store backup licenses on a network file share or have a configured backup license server ready in

case of license server failure.

Grace periods

If  the product cannot contact the license server due to a power outage or network problem, it continues to operate for
the grace period as though all licenses are available. If  the product cannot contact the license server by the end of this
period, the product stops accepting client connections until communication with the license server resumes. See your
product’s administrator guide for specif ic details on its grace period.
Note: Existing connections are never disconnected when the product enters the licensing grace period. When the grace
period expires, only new connections are denied.
Some notes about licensing grace periods across Citrix products:

When a Citrix product goes into a licensing grace period, an event is written to the Windows Event Log on the computer

running the product.

When a product enters the licensing grace period, Citrix XenApp Management Pack for Microsoft Operations Manager

2005 raises an alert. (Writing the grace period event to the Windows Event Log triggers this alert.)

When Password Manager enters the licensing grace period, it does not write any errors to the Windows Event log.

Instead, warning messages start appearing on the user’s desktop. You can tell if  a user entered the licensing grace period

by checking the information contained in the user’s notif ication area icon.

Redundancy solutions

Setting up redundancy solutions might be necessary only in mission-critical environments. For smaller or less mission-critical

deployments, you can back up your license server by creating a duplicate license server that can be stored on or off  the

network. For larger, more mission-critical deployments, you might want to create a clustered license server.

You can ensure redundancy for your license server by:
Duplicating the license server and its contents - Give the duplicate computer the same name as the active license server

and store it off  the network.

Using a network applicance - If  you are using only one license server to service license requests at any time, you can use a

network appliance that detects server or network outages and route traff ic to a backup license server.

Storing an additional license server on the network with a different server name - In this case, when the active license

server fails, you need to change the backup server name to start using it as the active license server.

Creating a clustered license server. For more information about clustering and licensing, see Setting up the License Server

on a Microsoft Cluster.

All methods let you exchange one server license for another without a loss of service, provided the exchange occurs within
the grace period. There are key points to remember:

Because license f iles reference the server specif ied during allocation, you can use the f iles only on a server with the same

binding information (server name or FQDN or Ethernet address) as the original license server

You cannot have two license servers with the same name on your network active at the same time

You must add any additional licenses that you download to both the active license server and the backup license server

http://docs.citrix.com/en-us/licensing/11-11-1/lic-cl-citrix-environment-c.html
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Frequently Asked Questions for Licensing

Mar 16, 2015

These are frequently asked questions about your licensing environment.

Can I rename the license server?

License files run only on the license server for which they were made. More specifically, license files contain the hostname or

binding identifier of the license server you specify when you allocate the licenses. You cannot use the license file that you

generated, which specifies a particular license server name, or a MAC address (in the case of an appliance.), with a different

license server name or appliance.

Create new license files that reference the new server name or MAC address by reallocating and generating the new file.

If  I upgrade my license server will it  affect my license files?

No. The license server and all product licenses are fully backward compatible and will not introduce any issues into your

environment.

Can a single license server supply licenses to users connecting from different servers using different
product editions?

Yes. One license server can contain licenses for multiple editions of a Citrix product. The type of license checked out

corresponds to the edition that is configured on the product server. A product server is configured to consume an edition of

a license and therefore will check out that edition of a license.

For example:

ProductServerA is configured to checkout Enterprise licenses.

ProductServerB is configured to checkout Platinum licenses.

LicenseServer1 contains both Enterprise and Platinum licenses.

Users who connect to LicenseServer1 from ProductServerA will check out Enterprise licenses only. Once the number of

Enterprise licenses on LicenseServer1 is exceeded, new requests from ProductServerA users will be denied until existing

Enterprise connection licenses are released.

Users who connect to LicenseServer1 from ProductServerB will check out Platinum licenses only. Once again, if  the

number of Platinum licenses on LicenseServer1 is exceeded, new requests from ProductServerB users will be denied until

Platinum connection licenses are released.

Note: License checkout times may increase if  many product servers with many users are contacting the same license server
simultaneously. One license server can accept only 10,000 inbound TCP-IP requests at one time. If  you are planning to have
more than 10,000 computers connecting at the same time, Citrix recommends that you use several license servers.
Examples of Possible Deployments:

Scenario 1: Two farms

FarmA contains product servers configured for Enterprise edition

FarmB contains product servers configured for Platinum edition

One license server (shared)
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User1, User2, User3, User4…User5000 connect only to FarmA

User5001, User5002, User5003…User10000 connect only to FarmB

Scenario 2: One farm

The farm has two sets of published applications

One set of applications is hosted by product servers configured for Enterprise edition

One set of applications is hosted by product servers configured for Platinum edition

One license server (shared)

User1, User2, User3, User4…User5000 connect only to product servers with the f irst set of applications

User5001, User5002, User5003…User10000 connect only to product servers with the second set of applications
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